WYOMING

DEPARTMENT OF EDUCATION

Centralized Reporting
User Guide

2023-2024

Revised March 26, 2024

Prepared by Cambium Assessment, Inc.

Cambium
Assessment

Descriptions of the operation of Centralized Reporting and related systems are property of Cambium
Assessment, Inc. (CAl) and are used with the permission of CAl.



Centralized Reporting User Guide

Table of Contents

(OF oL =1 [P4=To B a{=T o o] 4 A1 o IR RRPRPRI 1
L LY =T €T o = 1
INtroduction 10 the USEI GUILE.........uuuiiiiiiiiiiiii s 1
Overview of Centralized REPOITING .....cooeiiiiiieeeeiee e 1
Section |. How to Access Centralized RePOtiNg .......cooooviiiiiiiiiiiii e 2
How to Log In to Centralized REPOITING .......cooeiiiiiiiiiiieiiii e 2
How to Set or Reset YOUr PaSSWOId..........coooiiiiiiiiiii e 4
Section 1. HOw t0 Navigate REPOITS........coooiiiiiiiieeeeee e 6
How to Understand Which Students Appear in YOUr REPOIS ............uuuuemmmmimimimiiiiiiiiinnnnns 6
HOW 1O Start VIEWING REPOIS .. ..uuuuuiiiiiiiiiiiiiiiiiiiitiiiiiiiiiiieeb s 6
How to Use the Dashboard Generator PAge..........ccoooooiiiiiiiiiiiiisseeeee s 6
How to Use the Dashboard to View Aggregate Test ReSUIS ............cccoeeiiiiiiiiiiinns 7
How to View More Detailed Data on a Particular TeSt Group.........ccceeevmmmnimnmiiiinnns 8

For Teachers and School-Level Users: How to View Student-Level Data for All Your
SHUABNES e 10
How to View Test Results for Rosters on a Particular TeSt.............uuuuiviiiiiiiiiiiiiiiinnnns 12
How to Access Test Results for All YOUr ROSEEIS..........uuuuiiiiiiiiiiiee 12
How to See Which Rosters Performed Well on This Assessment...........cccoooevviiiiiiinennn. 14
How to See Which Rosters Had the Highest Test Completion Rates................ccceeeeenen 14
How to See How Well Rosters Performed in Each Area on the Test ........cccccceeiiinnnnnns 15
How to View and Interpret Writing Dimension MeasUres .........ccccevvveeeivveviiiiiiieeeeeeeeeiinnns 15
How to Access Test Results for an Individual ROSEEr ... 17
How to See How Well Students in Your Roster Performed in Each Area of the Test .....18

For School- and District-Level Users: How to View Test Results for a School on a

T[T T I 18
How to Access Test Results for @ SChOOI ........ccoooiiiiiiii 18
How to See Which Rosters Performed Well on This Assessment...........cccoooeeeieiiiieeennn. 19
For District-Level Users: How to View Test Results for a District on a Particular Test........ 19
How to Access Test ReSUILS fOr @ DISHCT .......ccoooeeeieieeiec e 19
How to See Which Schools in the District Performed Well on This Assessment............ 20
How to See How Well Schools in the District Performed in Each Area of the Test......... 20
How to View Test Results Broken Down by Demographic Sub-Groups..............ooeeeveeeeeees 20
How to View Test Results Broken Down by Demographic Sub-Groups..............ccccc..... 20



Centralized Reporting User Guide

How to Track Student Performance OVEr TIME .........uuuiiiiiieiiiiiiiiiee e e e 22
How to Access a Longitudinal Report Comparing Related Assessments....................... 23
How to View Students’ Overall Performance on These Assessments Over Time .......... 25
How to Switch Between Score Data and Performance-Level Data ..............cccccceeinnnnes 25
How to See Students’ Performance in Different Areas Over Time .........cccccovvvvevvveeinnnnnn. 26
How to Distinguish Different Types of Tests in the Graphs ..........ccccoeeeiiiiiiiiiiiiiiiiins 26
How to Modify the Test Groupings You've Selected ............cccoooiiiiiiis 26
How to Filter Test Opportunities to Show Some and Not Others..........cccccceevvveeeveeeeinnnnn. 26
How to Switch Between Score Data and Performance Level Data ..............ccccoeeinnnnnnns 27
How to Modify the Test Reasons You've Selected...........ccoovvviiiiiiiiiiiiiiiiei e 27

How to View Test Results for Individual StUdents..........cccooeeiiiiiiiiiiiii e 27
How to Access Test Results for an Individual Student on a Particular Test ................... 27

How to View a Report for All the Assessments a Student Has Completed Over Time ...28
How to Use the Student Portfolio Report to View Only the Tests You're Interested In ...29
How to View a Student’s Performance on Tests Taken in a Previous School Year or

=T U T O PTOPP 30
How to Use Individual Student Reports (ISR) ........oovuuiiiiiii e, 31
What an Individual Student Report (ISR) Looks Like and Howto Read It...................... 31
How to Generate and Export Individual Student Reports (ISRS) ........ccccvveevieieeiveeiinnnnn. 33
How to Generate and Export Student Data FileS .........ccooovieiiiiiiiiiiii e 38
How to Compare Students’ Data with Data for Your State, District, School, and/or
TOtAl STUAENTS ...ttt e e e eeeeees 43
How to Compare All Your Students’ Performance on Any Test with Larger Groups....... 44

How to Compare a Student’s Performance on Any of Their Tests with Larger Groups ..45

Section Ill. How to Set Up Your Reports for Summatives and Interims to Suit Your

AN == 0 46
HOW t0 Filter TEStS 10 DiSPIAY ..uvvuuiiii e e e e e e eaaaae 46
For Teachers and School-Level Users: How to Filter Rosters to Display .............cccceeevvnee. 47
For District-Level Users: How to Filter Schools to Display ...........ccccoeeviieiiiiiiiiiiiieecceeeeiin, 48
How to View Data from a Previous POINt in TIME..........uuuuuuuuiiiiiiiiiiiiiiiniiiiiiiiiiinnnnnnnnnnnnnens 49

Section V. How to Export and Print Data............cccoooiiiiiiiiiiiiiieee e 51
How to Export or Print a Report You're VIEWING ...........uuuiiiiiiiiiiiiiiiiiiiiineens 51
How to Export an Assessment Report Directly from the Performance on Tests
0] o0 ] 1 AU ORI 53
HOW t0 ACCESS IteM-LeVEI DAtaA.........cceiieiiiiiiiee e 55



Centralized Reporting User Guide

HOW O VIEW ITEIM SCOMES....ceiiiiiii et e e e e e e e e e e et e e e e e e eeeeesanes 55
How to Find Out Which Items Students Performed on the Best or Struggled with the
[0 F] PP UPPPTT 56
How to View Standards for EaCh ITem ..........coooiiiiiiiiiiii e 57
HOW O VIEW @N TTEIM ... e e e e e e e e e e e e eeaenanns 58
How to View ltems With and Without the Students’ Visual Settings ..............ccccceeiinnnns 60
How to Navigate to Other Items from the Item View WindOW ............ccccevvvvieiiiieevieeeinnnes 61
How to View Another Student's Response to the Current Item ..o, 61
What It Means When ltems Are Labeled “1-17, “1-2”, and SO On.........ccocoovvviviieiinennnnn. 62
What It Means When an Item Score Reads “N/a”..........cccoovviiiiiiiiiiiiiie e 63
How to Score Iltems on Teacher-Authored TESES ..........uuuuuiiiiiiiiiiiiiiiiiee 63
HOW t0 SCOre UNSCOIed ITEIMS .. ... e e e e e e eearanes 63
How to Change the Selected SChOOI ... 67
How to Submit Scored Test Opportunities for Processing.........cccoovveevveveiiiiiiiiieeeeeeeeiinnns 67
How to Modify Scores for [tems iN REPOITS ... 69
How to Set Up Your Interim and Modular REPOIS .........coviieiiiiiiiiiiiii e 71
How to Assign Test Reasons (Categories) to Modular Test Opportunities..................... 71
How to Filter Interim and Modular Test Opportunities by Test Reason (Category)......... 74
How to Filter Item-Level Data on Interims and Modulars by Standards and Clusters of
STANAANTS ...t 75
How to Export and Print Data on Interims and Modulars .............cccoooeieeiiiiiiiiiie e, 77

How to Export an Assessment Report Directly from the Performance on Tests Report .79

Appendix A. ROSTEr MaNaAgEMENT.......c.cciiiiiieiiie e eee e e e e e e e e et e e e e e eeeearana 82
HOW 10 Add 8 ROSTEN ..., 82
o (01T A (o T\ oo 11 V= W 2 (0 1 (=] SR 83
(o)A (o J W o[ = (o I o ] (=] £ 84
PaYo] o= gl [Dql = B @fo] oo 11 o) o [ 0o Lo [=7- 89
APPENIX C. HEIP GUILE.... ..o e e e e e e e e 91
How to Access the Online User GUIdE ..........ccooeiiiiiiiiiiiee e, 91
ApPeNdiX D. SECUIE FIle CONIEN ... .o 92
Access and Manage Files in the Secure File Center...........ccovviiiiiiiiieieiciiee e, 92
How to Use the Secure File Center to Send Files to Other Users’ Secure File Center
.................................................................................................................................. 94
Appendix E. Multiple Modular Test OppOrUNItIES .........oiiieeiiii e 96
Appendix F. Non-Scorable Test Opportunities ............coooi oo 97



Centralized Reporting User Guide

AppPeNndiX G. PerformanCe Datal............uuuuuuuuireiiiiiiiiiiiiiiiiiiiiii e 98
ApPPENdiX H. REPOIT TADIES .......uiiiiiiiiiiiiiiiieeee e nnnennees 100
How to Sorta Table.........ooo 100
How to Specify the Number of Rows Displayed............ccccooiiiiiiiii, 100
How to View Additional Table ROWS ... 100
How to View Additional Table Columns ... 100
How to Expand All Accordion Sectionsina Table............cccc 100
APPENTIX |. TEST RESOUITES ...ttt 101
APPENiX J. USEr ROIE CRANGE ......uuuiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiie e 102
0TS RS 0] o] o 1o ] S TP PP PP 103



Centralized Reporting User Guide

Introduction to the User Guide

This user guide provides instructions and support for users viewing test results in Centralized Reporting.
This section describes the organization of this user guide and provides an overview of Centralized
Reporting.

This user guide gives instructions on using Centralized Reporting to access summative, interim, and
modular assessment data.

This user guide includes the following sections:

e Section |. How to Access Centralized Reporting
e Section Il. How to Navigate Reports

e Section lll. How to Set Up Your Reports

e Section IV. How to Export and Print Data

® Section V. How to access Interim and Modular Data

There is also an Appendix A. Roster Managementwith additional information.

Overview of Centralized Reporting

e Centralized Reporting provides student performance reports for summative, interim, and
modular assessments. Centralized Reporting consists of a Dashboard page and various
Assessment Reports. The Dashboard provides a summary of all the assessments associated
with a particular user or institution, and the Assessment Reports provide detailed performance
data for each of those assessments.

® Assessment Reports are available at various levels within a district. Access to each Assessment
Report depends on your user role.
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Section I. How to Access Centralized Reporting

This section describes how to log in to Centralized Reporting.

Do not share your login information with anyone. All Wyoming systems provide access to student
information, which must be protected in accordance with federal privacy laws.

How to Log In to Centralized Reporting

1. Navigate to the Wyoming Assessment portal (https://wyoassessment.org/).

2. Select your user role from the cards displayed (see Figure 1).
Figure 1. User Role Cards

WY-TOPP

E E
Students and Families Educators
Access practice tests and other Access systems and resources
resources. used before, during, and after
testing.

USER USER

WY-ALT Students and Families WY-ALT Educators

Access practice tests and other Access systems and resources

resources. used before, during, and after
WY-ALT testing.

3. Click the Centralized Reporting System card (see Figure 2). The login page appeatrs.


https://wyoassessment.org/
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Figure 2. Centralized Reporting Card

Centralized Reporting System

Access and download student results and
view reports on student performance

4. On the login page (see Figure 3), enter the email address and password you use to access all CAl
systems.

Figure 3. Login Page

Login
Please Log In
Enter your username and password to log into AIR Assessment
online systems. Once you log in, you will automatically be directed B Email Address

1o your selected system.

Need More Help?
eed Hore ielp m Password

I you forgot your password or need a new password, please
use the Forgot Your Password link to reset it Forgot Your Password?

For assistance, contact the WV Help Desk at 1-844-560-7367 Si Logi
wnhelpdesk@air org ecure Login

First Time Login This School
Year?

The password you used during the previous
school year has expired

Request a new one for this school year.

Click Secure Login.

If the Enter Code page appears (see Figure 4), an authentication code is automatically sent to your email
address. You must enter this code in the Enter Emailed Code field and click Submit within 15 minutes.

If the authentication code has expired, click Resend Code to request a new code.
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Figure 4. Enter Code Page

Enter Code

< A code has been sent fo your email address. The code
will expire after 15 minutes

E Enter Emailed Code

Resend Code

Cancel

If your account is associated with multiple institutions, you are prompted to select a role (see Figure 5).
From the Role drop-down list, select the role and institution combination you wish to use. You can also
change your institution after logging in.

Figure 5. Select Role Window

Select Role

Please select the role you wish to use

Role: Role Name @ Entity: Entity Name v

The dashboard for your user role appears.

How to Set or Reset Your Password

Your username is the email address associated with your account in TIDE. When you are added to TIDE,
you receive an activation email containing a temporary link to the Reset Your Password page (see Figure
6). To activate your account, you must set your password within 15 minutes.

All users are required to do a one-time password reset at the beginning of every school year, for security
purposes.
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Figure 6. Reset Your Password Page

Reset Your Password

Reset Your Password

Enter your email address and select Submit. You will receive an

email that contains a link lo create a new password. B E-mail Address

Need More Help?

If you forgot your password or need a new password, please “

use the Forgot Your Password link to reset it
Return to Login Page

For ', contact the WV Help Desk at 1-844-560-7367
wvhe air org

e If your first temporary link expired: In the activation email you received, click the second link
provided and request a new temporary link.

e If you forgot your password: On the Login page, click Forgot Your Password? and enter your
email address in the E-mail Address field. Click Submit. You will receive an email with a new
temporary link to reset your password.

e [f you did not receive an email containing a temporary link or authentication code: Check your
spam folder to make sure your email program did not categorize it as junk mail. If you still do
not see an email, contact your Building or District Test Coordinator to make sure you are listed
in TIDE.

e Additional help: If you are unable to log in, contact the Wyoming Helpdesk for assistance. You
must provide your name and email address.
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Section Il. How to Navigate Reports

This section explains how to navigate your reports for both summative and interim assessments.

How to Understand Which Students Appear in Your Reports
e Teachers can view data for all students in their rosters who have completed assessments.
e School-level users can view data for all students in their schools who have completed assessments.

e District-level users can view data for all students in their districts who have completed assessments.
How to Start Viewing Reports

How to Use the Dashboard Generator Page

When you log in to Centralized Reporting, the Dashboard Generator page appears (Figure 7). The
controls on the left let you select from the groups of tests that have been processed for the selected
school year. Typically, you may choose test types, subjects within the test types, and grades within the
subjects.

Test types may include Teacher- Authored, which comprises tests created in the Authoring system. The
Field Authored type does not list subjects or grades as subcategories. If a field-authored test opportunity
requires hand scoring for any item, it will not appear in reports until educators have provided scores for
all items in the hand scoring module.

Figure 7. Dashboard Generator Page
Select Role * pashboard Generator

These are 2023-2024 school year reports. Change the reporting time period.

W:L?’h test groups would you like to start Looking for a specific student? EEE Features & Tools
e Get the resulls of a student by entering their

~ B ELPA Screener student ID Reporting Opticns ~

han T
W English Prafciency Ailer Studenl m E EE:SEGHGW"W me

Download & Print ~
Make these my defaull selections.
gl_ Download Studem

"} Resuls
Go to Dashboard
Test Options A

— " Set Studént Seating on
= = !
2 & Manage Tesi Reasons S ernvi

Roster Settings N

+ Add Roster @ View/Edit Roster

i‘ Upload Roster

To the right of the dashboard generation controls are some other useful features. The Looking for a
specific student? section allows you to use student ID to view all that student’s test results. The Features
& Tools menu appears on the right side of this page and in reports and offers multiple features that are
described elsewhere in this guide.
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If the Dashboard Generator shows a message saying there are no data, that means no test opportunities
are available for this school year.

1. Optional: To change the test groups listed in the Dashboard Generator, change the reporting time
period.

2. Select the tests you want to view, expanding the test groups as needed.

3. Optional: To save your selections, mark the checkbox Make these my default selections. These
selections will be set in the Dashboard Generator whenever you log in. You can change the defaults
at any time.

4. Click Go to Dashboard. The dashboard appears, displaying any data available for your selections.

How to Use the Dashboard to View Aggregate Test Results

All users except state-level users can view the standard dashboard (Figure 8). It displays aggregation
cards representing test groups.

Each aggregation card displays the test group name, a list of grades, the number of students who took
tests in the group, the date of the test last taken, and a performance distribution bar displaying both
percentages and student counts below it. You may sometimes see the message “Data cannot be
aggregated together for this group of tests” instead of the performance distribution bar for tests that do
not report performance distribution, or that use different sets of performance levels. Test group cards
are sorted by date last taken.

Clicking the @ button beside the performance distribution bar displays a legend with more information
about performance levels.

Figure 8. Dashboard

Select Role » Dashboard Generator » Dashbeard Q,
=k
== Performance Distribution, By Test Group: Demo District 9998, 2023-2024 ves
Fiers Filterind By Test Aeassns All Tost Feasons | Sorted By: Date Lost Taien 11 Features & Tools
2 ~77| ELPA21 Screener English Reporting Options A
Tesz ! Praficiency .
Orougn Change Reporting Time
Grades Tested: KG, 00,1, 3,5, 10, Period
— 12
(] Tests Taken & Download & Print S
Tes
[ Date Last Taken: 07/18/2023 L. Download Student @ "
a‘ Results Print
[N »
Teest Options A
Perent 0% 50 -
a . = . ve] SilStudent Setting on
Eé Manage Test Reasons 20 Nem View
Roster Settings ~
4 addroster @) View/Edn Roster
‘I' Upioad Roster

If a message appears saying “There are no assessments to display,” you may not have any students who
have taken tests in your selected test groups in the selected time period. You can change the reporting
time period. If you are a teacher, you may also be able to view more students’ data by managing your
rosters.
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To change the test groups and test reasons that appear, use the Filters panel on the left. For more
information on filtering, see Section Ill. How to Set Up Your Reports. You can also backtrack to the

Dashboard Generator using the link in the path at the upper-left corner and change your test group
selections there.

How to View More Detailed Data on a Particular Test Group

To view more detailed data for a particular test group, click the name of the group. The Performance on
Tests report appears. It is filtered to display only the test group you selected.

In the Performance on Tests report, teachers see two tables (see Figure 9):

e The My Assessments table, listing all the assessments in the filtered test group or groups.
e The My Students table, listing all your students who took the assessments.

Figure 9. Teacher View: Performance on Tests Report

Select Role * Dashboard Generator * Dashboard * Performance on Tests Enter Student IL Q
=
- # My Assessments

it Features & Tools
Fihers

Average Score and Performance Distribution, by Assessment: All Rosters, 2022-2023
Filtered By Rosters: All Roster | Test Reasons: All Test Reasons |

el ]
i1
Tem

b Assessment Name Test Group Test Grade Test Reason Séﬁ:l;ﬂ Average D?rl:k:ﬂ ¥
'%_'é &, | Test 547498 Math 1/19 »  Test Authoring ] Unassigned 1 0% @ 011972023
n!:l:'ﬂl
‘i, Test 547499 Science 1/19 % Test Authoring 4 Unassigned 1 % o 01/19/2023
Raosters
&, | Test 546812 WV 1/17 '  Test Authoring 6 Summer 2023 1 0% @ 01/17/2023
Rows perpage: 3 5 tems: 1 of2 »

A My Students

Most Recent Assessment of All Rosters: 2022-2023
Filtered By Rosteérs: All Roster | Test Reasons: All Test Reasons |

Studant Name Student ID Mast Recent Assessment Date Taken
Test Test 716623001 Test 547498 Math 1/19 01192023
Rows per page: 6 1 hems: 1 af1

District- and school-level users see just one table (see Figure 10). Like the first table on the teacher
Performance on Tests report, this table lists all the assessments in the test group.
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Figure 10. School-Level User View: Performance on Tests Report

Select Role * Dashboard Generator * Dashboard * Performance on Tests Emter Student |0 Q
'_T|—: Average Score and Performance Distribution, by Assessment: zzz Cambium Training District, 2022-2023 i3 Features & Tools
Filsers Filiered By School: All Schools | Test Reasons: All Test essors |
E‘.'.. Aszsessment Name Test Group Test Grade Test Reason
Tent
Interim ES Earth and Space Science - PE
J L = - '’ -
& essig W Initesim 5 Unassigned 4 = : ] 122172022
5 -
Rovecne & %?PMSETSE&S‘“D“M W Interim & Unassigred 1 o5 O 12472022
&4 4 | ioterimESEarth and Space Science - PE - -
& | sessra W Interim 5 Unassigned 1 [ ] r2araee
&, | Interirm M3 Life Science - PE MS-L53-1 A Inerim ] Unassigned 1 15 @ /222022
Rowsperpage: 4 = 42 items: < 1 ofnl

For each test, the assessments table (see Figure 11) shows the test group, grade, test reason (the name
of the test window of a summative assessment, or a category assigned to an interim assessment),
number of students who took the test, average score, performance distribution, and date the test was
last taken.

Figure 11. Teacher View: Performance on Tests Report

Select Role * Dashboard Generator * Dashboard » Performance on Tests Enter Student ID Q
Ix .

== A My Assessments i1t Features & Tools
[Filiers

Average Score and Performance Distribution, by Assessment: All Rosters, 2022-2023
[i—:l Filtered By Rosters: All Roster | Test Reasons: All Tés! Réasons |

G Average Date Last
Pe Assessment Name Test Group Test Grade Test Reason 5 Taken ¥
_ ’ r———
:Gé & 1 498 Math 1/1 s Test Authoring [ Unassigned [ i ] 01/19/2023
Pesions
E &, Test5474 i 11 “  Test Authoring 4 Unassigned ™ 9 01/19/2023
Rasters
d T 11 »  Test Authoring [ Summer 2023 R ] 072023
page: Shems: < 1 3
#« My Students 3
Most Recent Assessment of All Rosters: 2022-2023
Filtered By Rosters: All Roster | Test Reasons: All Test Reasons |
Student Name Student ID Most Recent Assessment Date Taken
Test Test 716623001 Test 547498 Math 1/19 0171972023
Rows perpage: |6 = 1 ems: < 1 of1 »
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Table 1. Teacher View: Performance on Test Report Elements

Element

#

1 Test reasons (set in TA interface when administering tests)
2 Number of students who took each test for each test reason
3

Date of most recent opportunity for each test for each test reason

You can use the filters to view a different set of assessments. For more information on filtering, see How
to Set Up Your Reports for Summatives and Interims and How to Set Up Your Interim and Modular
Reports.

If a message appears saying “There are no assessments to display” or “There are no students to display”,
you may have filtered out all data.

For Teachers and School-Level Users: How to View Student-Level Data for
All Your Students

The Performance by Student tab of the My Students’ Performance on Test report displays test results
for each of your students across rosters. In order to see the results for all your students, follow the
instructions below.

1. Generate a dashboard and click a test group name.
2. Click a test name in the assessments table at the top of the page.

3. Inthe My Students’ Performance on Test report that appears, select the Performance by
Student tab, as in Figure 12. The results that appear list all your students. The first few rows also
show aggregate performance data for your state, district, school, and total students.

10
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Figure 12. My Students’ Performance on Test Report: Performance by Student Tab

Select Role » Dashboard Generator > Dashboard » Performance on Tests > My Students’ Performance on Test Enter Student ID Q,
i :
== |Perrormance by Rosler| Performance by Student ii: Features & Tools
Score, Performance and Points Eamed on +Benchmark Grade 4 ELA (15t opportunity) of All Rosters; and Reporting Category: ,
2023-2024
Fitered By Rosters: All Roster | Test Reasons: 152 oppoctunity | 1
4 Stdentin ¢ ® O 00
- Report ]
a ed Lexle® |
2 Scale Score ¢ e $ Performance 2 @ 2
2 & 8 3
§ ¢ 8
2
7~ N\ & 8"
State nfa nfa nia g g
g =4
%
District 563 @ n/a f— 100% e E’
Conmn 1 =
)
s we | | —
Courn 1
o
- = ”
S 1
3 SampleLN193, SampleFN192 | 100000192 563+21 @ 665L @ Partially Meets Standard
Rows perpage: 4 O 1iems: ¢ 1 of1

Table 2. School Performance on Test Report: Performance by Student Tab Elements

1 Performance column header (click to sort)
2 Data for district and school

3 Student data

To find out which students performed best, click the score or Performance columns to sort them.

You can view your students’ performance in each area of the test by clicking the reporting category
section bars to expand them, as shown in (see Figure 13).

11
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Figure 13. My Students’ Performance on Test Report: Performance by Student Tab with Expanded
Reporting Category Section

Select Role » Dashboard Generator > Dashboard > Performance on Tests > My Students' Performance on Test Enter Student ID Q

Performance by Roster || Performance by Student :32 Features & Tools

Score, Performance and Points Earned on +Benchmark Grade 4 ELA (1st opportunity) of All Rosters, by Student and Reporting Category:,
2023-2024
Filtered By Rosters: All Roster | Test Reasons: 1st opportunity |

Student 4 Studentip © @ e o
# &5 g =
g 2 g 2
S S a
‘S Scale Score Performance ‘; @
o gz
. z i
g i g
= =
State n/a n/a S
=4
g
District n/a Percent 100%
1 Count 1
777 o
School nfa Percent 100%
Count 1
V7777 o
My Students n/a Percent 100%
Count 1
SampleLN192, SampleFN192 | 100000192 \431:437 (] Below Mastery /

Rows per page: 4 1 Items: 1 of1

Table 3. My Students’ Performance on Test Report: Performance by Student Tab Elements

# Element
1 Reporting category section (expanded)
2 Additional reporting category sections (not expanded)

How to View Test Results for Rosters on a Particular Test

You can view a list of rosters that took a particular test, and you can also view the test results for a
particular class.

How to Access Test Results for All Your Rosters

The Performance by Roster tab (see Figure 14. My Students’ Performance on Test Report: Performance
by Roster Tab) displays test results for each roster. To view this tab, follow the instructions for your user

role below.
Teachers and school-level users:
1. Generate a dashboard and click a test group name.

2. Click a test name in the table of assessments. Either the My Students’ Performance on Test or
the School Performance on Test report appears, depending on your role. It is open to the
Performance by Roster tab.

12
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District-level users can view all classes (rosters) in a school. To do so, follow these instructions:
1. Generate a dashboard and click a test group name.

2. Click a test name in the table of assessments. A page of district test results appears, listing
schools within the district.

3. Click a school name. The School Performance on Test report appears, open to the Performance
by Roster tab.

The report shown in Figure 14 displays a list of your rosters and the performance of each class. The first
few rows also show aggregate performance data for your state, district, school, and total students.

Figure 14. My Students’ Performance on Test Report: Performance by Roster Tab

Dashboed Generaior > Dashboard > Performance oo Tests > My Students’ Performance on Test Enter Stadent 1D Q
1 Performance by Roster | Performance by Student
Average Score, Performance Distribution and Average Points Earned on Grade 8 Alt ELPA (Spring 2023 - Alt ELPA), by Roster and Reporting Category: 2022-2023
Filterd By Rosters: All Roster | Test Reasons: Spring 2073 - A ELPA |
Roster * 0 00000
=l lgelpy
St A Test : Average . Avecage Percent 5 g g g g g
S Rate ScéleScore Scale Score Proficent
VI © g § i i E i
District 1 4198 3950 Fercent 190 %
Count ) E
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Table 4. My Students’ Performance on Test Report: Performance by Roster Tab Elements

1 Performance by Roster tab

2 Performance data for a roster
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How to See Which Rosters Performed Well on This Assessment
To see which classes performed best on the test, do either of these things (see Figure 15):

e Click the score column header to sort by score and look for rosters with high average scores.

e Look at the bars in the Performance Distribution column to see where the percentage of students at
or above proficient is high.

Figure 15. My Students’ Performance on Test Report: Performance by Roster Tab
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Table 5. My Students’ Performance on Test Report: Performance by Roster Tab Elements

# Element

1 Test Completion Rate column (click to sort)
2 Scale Score column (click to sort)

3 Performance Distribution column

How to See Which Rosters Had the Highest Test Completion Rates

To see which rosters had the highest test completion rate, click the Test Completion Rate column header
to sort the column (see Figure 15).
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How to See How Well Rosters Performed in Each Area on the Test

For tests with reporting category sections, you can compare the performance of your students in each
area of the test. Click each vertical section bar to expand or collapse it. In this example (Figure 16), you
can view average score and a performance distribution bar for each roster under the reporting category
2b. Domain: Reading.

Figure 16. My Students’ Performance on Test Report: Performance by Roster Tab with Expanded
Reporting Category Section

Dashbosed Generaior » Dashoard » Performancs on Tests > My Stadents’ Peformance on Test Q
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Table 6. My Students’ Performance on Test Report: Performance by Roster Tab with Expanded
Reporting Category Section Elements

# Element
1 Reporting category section bars (click to expand)

2 Reporting Category Section

Summative and interim tests cover multiple reporting categories, while a modular test covers only one.

How to View and Interpret Writing Dimension Measures

Test results for some assessments may also include a Writing Dimensions section to the right of the
expandable sections in the report table. You can expand it by clicking the vertical bar, just as with the
reporting category sections. This section helps you understand how students performed on different
aspects of writing.

The Writing Dimensions section (see Figure 17) contains the following under the Essay header:

e Essay type. For example, Informative, Explanatory, Opinion, and Argumentative.

=  Writing dimension within the essay type, as listed in item rubrics. For example, Statement of
Purpose/Focus and Organizations, Evidence/Elaboration and Conventions/Editing.
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- Point value. A sub-column for each possible item point value for the writing dimension.
Each point value sub-column displays the percentage and number of students who
earned that number of points.

For each dimension, the lowest . and highest [ & point values are sometimes highlighted
and marked with arrow icons in the rows with the highest percentages. This allows you to
quickly identify groups of students who are performing well and those who may need
additional support.

Note that highlighting and arrow icons do not appear where they are not useful. A report
containing only one row of data does not have them, and neither does a row in which the

percentages are “n/a” or are all the same.

Figure 17. District Performance on Test Report with Expanded Writing Dimensions Section
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Table 7. District Performance on Test Report Elements
# Element
1 Essay type header
2 Writing dimension header
3

Point value
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To learn about the highlighting and arrow icons, click the more info button o in the Essay header. A
legend expands, as in Figure 18.

Figure 18. District Performance on Test Report with Expanded Writing Dimensions Section and
Expanded Legend
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How to Access Test Results for an Individual Roster

Prior sections explained how to access test results for all your rosters. To view results for one specific
roster, click the name of a roster that appears in the first column of the report. The roster results listed

by student appear (see Figure 19).

Figure 19. School-Level User: Roster Performance on Test Report
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How to See How Well Students in Your Roster Performed in Each Area of the Test

You can compare the performance of your students in each area of the test using the reporting category
sections, as shown in Figure 20. Click the vertical section bar to expand each section.

Figure 20. School-Level User View: Roster Performance on Test Report with Expanded Reporting
Category Section
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For School- and District-Level Users: How to View Test Results for a
School on a Particular Test

You can view test results for all the students in a school on a particular test. This gives you a high-level
look at how the school is performing.

How to Access Test Results for a School

School-level users:

1. Generate a dashboard and click a test group name.

2. Click a test name in the table of assessments. The School Performance on Test report appears.
District-level users:

1. Generate a dashboard and click a test group name.

2. Click a test name in the table of assessments. A table listing test results by school appears.

3. Click the name of the school for which you would like to view results. The test results for the school

appear.
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Note that district-level users can also access the test results from a school directly from the Performance
on Tests report, by first filtering by school.

The Performance by Roster tab is open by default, as in Figure 21.

Figure 21. School Performance on Test Report: Performance by Roster Tab
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How to See Which Rosters Performed Well on This Assessment

In the Performance by Roster tab, look at the Performance Distribution column and click the header of
the score column to sort by score. Rosters with a high average scale score, and with a high percentage of
students performing at or above proficient in the performance distribution bar, performed well on the
assessment. If certain rosters performed consistently well, you could use them as a model for the classes
with lower performance.

For District-Level Users: How to View Test Results for a District on a
Particular Test

You can view test results for a district on a particular test. This gives you a high-level view of how the
district is performing.

How to Access Test Results for a District

1. Generate a dashboard and click a test group name.

2. Click a test name in the table of assessments. The District Performance on Test report appears,
listing schools in the district (Figure 22).
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Figure 22. District Performance on Test Report
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How to See Which Schools in the District Performed Well on This Assessment

Look at the score column and/or Performance Distribution column, and click the score column to sort by
it.

How to See How Well Schools in the District Performed in Each Area of the Test

Click the vertical section bars to expand the reporting category sections (see Figure 23).

Figure 23. District Performance on Test Report with Expanded Reporting Category Section
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How to View Test Results Broken Down by Demographic Sub-Groups

You can use the Breakdown By button in the Features & Tools menu to compare performance between
different demographic sub-groups. This button is available for most aggregate test results.

How to View Test Results Broken Down by Demographic Sub-Groups

1. Click Breakdown By in the Features & Tools menu. The Breakdown Attributes window opens
(Figure 24).
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Figure 24. My Students’ Performance on Test Report: Performance by Student Tab: Breakdown
Attributes Window

Breakdown Attributes

Select up to three options

[C] Ethnicity [[] Gender
[[] Grade [[] Migrant Student
7] Virtual Education Student

] Include unspecified values

Apply ‘ Cancel |

2. Select up to three student demographic categories.

There is also an Include unspecified values checkbox, explained below:

- Some students who complete tests do not have specific demographic information in the Test
Information Distribution Engine (TIDE). These students are considered to have unspecified
values.

- Toinclude data for these students, mark the checkbox.

3. Click Apply. Data for each sub-group selected are displayed in the report.

Figure 25. Demographic Breakdown of a School Performance on Test Report
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View Test Results for a Particular Demographic Sub-Group or Combination

When viewing test results broken down by sub-groups, go to the row for the demographic combination
you want to view and click the view button in the View Details column on the left (Figure 25).

A window opens, displaying detailed results for that combination. The report table is now laid out the
same way as the original report, before you viewed it broken down by sub-groups (Figure 26).
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Figure 26. Demographic Combination Breakdown Window (from School Performance on Test Report)
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At the top of the report table are filter menus for each demographic category you chose. To change the
demographic combination displayed, use the filters to select the demographic sub-groups you want to
view and click Apply. The new combination is displayed.

You can use this window to get an in-depth look at specific groups of students. For example, you may
want to determine which rosters have the highest-performing girls in the first grade.

How to Track Student Performance Over Time

You can view your students’ performance over time across multiple related assessments or across
multiple test opportunities of a single assessment. This lets you see how students’ performance has
improved or declined.

Each Longitudinal Report displays performance data for one of the following:

e A group of students who have completed every assessment available in the report. If you are a
district- or school-level user, note that a certain percentage of students must have taken all the
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related assessments in order for you to generate a Longitudinal Report. Teachers have the option of
adjusting the pool of students, tests, and test reasons

e Anindividual student (see Figure 27).
Figure 27. Longitudinal Report Window: Summative Report for a Single Student with Multiple Reporting
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How to Access a Longitudinal Report Comparing Related Assessments

If the student(s) in your test results have completed multiple related assessments, the Build
Longitudinal Report button allows you to access a Longitudinal Report in the reports for any of those
assessments. If they haven’t done so, then no Longitudinal Report is available.

Click the Build Longitudinal Report button in the Features & Tools menu.

The Longitudinal Report window appears. Depending on your role, the test types, and the number of
students in the report, it may display a report options page rather than the Longitudinal Report itself.
The contents of this page depend on your role and the number of students.

= |fyou are viewing a Longitudinal Report for which both interims and summatives are available,
the Progression drop-down list (Figure 28 and Figure 29) appears. Use it to select which test
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types to view in the Longitudinal Report: summative, interim, or a combination. This drop-down
list does not appear when only one test type is available.

Figure 28. District-Level User View: Longitudinal Report Window: Report Options Page with Progression
Drop-Down List Only

Longitudinal Report

Progression  Select

Generate Report

Teachers only: If the test results you’re looking at are for multiple students, a table appears

with a column for each test (see Figure 29). This table does not appear if you’re looking at an
individual student.

A sub-column appears for each test reason (a category of test, or, for a summative, a
test window).

The cells in the columns display checkmarks ¥ toindicate which students completed
which test/test reason combinations.

Figure 29. Teacher View: Longitudinal Report Window: Detailed Report Options Page
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Coreals B Mark the checkboxes for the tests you wish to compare, and then click Generate Report. The Longitudinal Report will
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Mark the checkbox for each test/test reason combination you wish to include in the
report. Mark the Test Reason checkbox on the left to include all, or clear it to remove
all. The test opportunities that will be included are highlighted in yellow.

= |If you’re viewing report options, click Generate Report at the top of the window to view the

Longitudinal Report. (You can modify your selections and regenerate the report later using
the Change Selections button.)
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How to View Students’ Overall Performance on These Assessments Over Time

Look at the graph in the upper-left corner of the Longitudinal Report (see Figure 30). It shows the scores
or performance levels of the student(s) each time they took the test(s).

Score data are plotted along a line.

Figure 30. Longitudinal Report Window: Summative Report for a Single Student with Multiple Reporting
Categories
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Performance level data are shown either the same way or, for multiple students, in performance
distribution bars.

Mouse over the data points in a line graph or the sections in a bar to get more information.

Alternatively, in the table at the bottom of the report, look at the Overall section.

How to Switch Between Score Data and Performance-Level Data

When a graph offers both score and performance level data, a toggle bar appears at the top of it. Click
the toggle to switch. You may want to do this if you find performance level data easier to read, or if you
prefer the precision of score data. Sometimes a test includes only one type of data.
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How to See Students’ Performance in Different Areas Over Time

Look at the reporting category graphs to the right of the overall performance graph, or look at the
expandable reporting category sections in the table at the bottom. Here, you can see at a glance how
students are improving or declining in each area, and you can compare their trajectories in different
areas.

How to Distinguish Different Types of Tests in the Graphs

A symbol appears on each data point. When multiple test types are present, refer to the legend
immediately below the graphs (see Figure 30) to find out which symbols correspond to which types.

How to Modify the Test Groupings You’ve Selected

If you generated the report from the report options page, click the Change Selections button in the
upper-right corner of the window. The report options page reappears, allowing you to change your
selection of test type or types and, if you are a teacher viewing multiple students, your selection of tests
and test reasons as well.

Alternatively, if your report contains multiple test types, click the test type toggles in the legend
immediately below the graphs (see Figure 30) to hide and show data for each one. Note that these
toggles do not affect report printouts or exports.

How to Filter Test Opportunities to Show Some and Not Others

You may want to filter a Longitudinal Report in order to focus on some test opportunities and not
others.

Note that filtering tests may affect the set of students whose data are included in the report.

1. Open the Filters menu at the upper-right corner and select the filter options you prefer from the
drop-down lists.

* You may want to filter by a particular school year or years. Note that years are not calendar
years (i.e. 2023 refers to the 2023-2024 school year). By default, Longitudinal Reports show
data for all years.

Longitudinal Reports can show student performance from a time when the students were not
yet associated with you. For example, if you are a seventh-grade teacher, you can use these
reports to view your current students’ performance on last year’s sixth-grade tests.

» [fthe reportincludes interim assessments, you may wish to filter by a test reason (a category
of test), which means excluding all other test reasons from the data. For example, you may
want to narrow the report down to show only tests taken in the spring. For summative
assessments, test reasons are the same as test windows and are not useful.

*  Finally, you may find that certain individual tests are less relevant than others. In that case,
you can use the Test Label options to deselect the names of the tests you don’t want to see.
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2. Click Apply.

3. Optional: To revert all filters to their defaults, open the Filters menu again and click Clear Filters.
Click Apply.

A row of filter details appears below the report header, showing the test reasons and school years
included in the report.

How to Switch Between Score Data and Performance Level Data

When a graph offers both score data and performance level data, a toggle bar appears at the top of it.
Click the toggle to switch between data. You may want to do this if you find performance level data
easier to read, or if you prefer the precision of score data. Sometimes tests include only one type of
data.

How to Modify the Test Reasons You’ve Selected

Click the Change Selections button in the upper-right corner of the window. The report options page
reappears, allowing you to change your selection of test reasons. Click Generate Report again.

How to View Test Results for Individual Students

You can find out how well an individual student understands the material covered on a specific
completed assessment. You can also view a report for all the assessments a student has taken.

How to Access Test Results for an Individual Student on a Particular Test

Teachers and school-level users:

1. Generate a dashboard and click a test group name.

2. Click a test name in the table of assessments. A page of test results appears.
3. Select the Performance by Student tab.

4. Click the name of an individual student in the report. The Student Performance on Test report
appears (Figure 31).

District-level users:
1. Generate a dashboard and click a test group name.
2. Click a test name in the table of assessments. A page of test results by school appears.

3. Click a school name. The School Performance on Test report appears.
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4. Perform the same steps as teachers and school-level users, starting at step 3.

Figure 31. Teacher View: Student Performance on Test Report
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You can view the student’s performance in each area of the test using the reporting category sections,
which you can click to expand.

How to View a Report for All the Assessments a Student Has Completed Over Time

The Student Portfolio Report allows you to view all the assessments an individual student has completed
over time. This is useful for viewing performance on tests that have multiple opportunities, and for
interim tests that were administered multiple times throughout the year.

To access this report, enter the student's SSID in the search field in the upper-right corner and click the
search button. (When you are viewing the Dashboard Generator and data are available, the same field
appears to the right of the dashboard generation controls.) The Student Portfolio Report appears (Figure
32).

Teachers can also access this report from the Performance on Tests report by going to the My Students
table below the main assessments table and clicking a student's name.
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Figure 32. Student Portfolio Report

Select Role » Dashboard Generalor » Dashboard > Student Portfolio Q,
— .
i= Score and Performance, by Assessment and Test Reason: LAST1179 First1179, 2022-2023 222 Features & Tools
Filkera
Test Test Test Student Date
|iE:ﬁ Assessment Mame Group Grade Reason c Score Performance Taken ~
-n

Tewt e
Growps | | Sumnative Grade 8 ELA A Summative 8 i@i;ﬂfﬂ;ﬁfﬁ?} 1 605 £ 13 n”;': q’:g:‘;w 03/14/2023
Summative Grade 8SCIENCE A Summative 8 [ssimrﬁﬁ\?j] 1 82427 Does Not Meet | 03/09/2023
Sched
e Spring 2023 Does Not Mest ,

T ey tn rad + F

Sumimative Grade § MATH . Summative ] (Summative) 1 495+ 21 Standard 03/03/2023

Rows per page: 100 3 hemns: 1 aof1

To view individual test results for this student, click a test name.

How to Use the Student Portfolio Report to View Only the Tests You’re Interested In

You can temporarily filter which tests you want to see in the Student Portfolio Report. You may want to
do this, for example, if you are an ELA teacher and you don’t want to see a student’s math scores. By
default, the data for those math assessments appear in the report, but you can exclude them.

1. Inthe Filters panel on the left side of the Student Portfolio Report, click the Test Groups button. The
Filters panel expands (Figure 33).

2. Mark as many selections as you like in the Test Groups section of the Filters panel. Tests are
organized by test type, subject, and grade.

3. Click Apply. The Student Portfolio Report updates to show only data for those tests.

4. Optional: To revert all filters to their defaults, open the filters panel again and click Clear Filters.
Click Apply. Filters also revert when you log out, switch user roles, or switch systems.
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Figure 33. Student Portfolio Report with Expanded Filters Panel
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How to View a Student’s Performance on Tests Taken in a Previous School Year or
Years

If there are multiple years of data for a student, the Student Portfolio Report can look back at previous
years. This gives you a high-level look at the student’s progress. Student Portfolio Reports can show
student performance from a time when the students were not yet associated with you. For example, if
you are a seventh-grade teacher, you can use these reports to view a current student’s performance on
last year’s sixth-grade tests.

1. Onthe left side of the page, click the School Year button. The Filters panel expands.

Figure 34. Student Portfolio Report with Expanded Filters Panel
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2. Under School Year, select a year or years (see Figure 34).
3. Click Apply.

To switch back to the current year:

1. Open the Filters panel again.

2. Click Clear Filters.

3. Click Apply.

How to Use Individual Student Reports (ISR)

This section discusses Individual Student Reports (ISR), each of which provides easy-to-read
performance data on a student’s test. If a student took tests multiple times, an ISR will be available for
each test opportunity (an instance of a test the student took). ISRs are useful for sharing performance
information with students and their parents and guardians and may be generated in English or Spanish.

What an Individual Student Report (ISR) Looks Like and How to Read It

An ISR is a PDF that shows test results for a test opportunity. It may consist of a single page or multiple
pages. ISR layouts vary according to the type of test. Details of sample ISRs are shown below in Figure
38, Figure 39, and Figure 40.
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o Atthe top of each ISR are the student name and WISER ID, the name of the test, district,
school, and any other relevant information.

o Below that is a summary of the student’s performance. An ISR for a scale-scored test displays
the student’s performance on a vertical scale that includes all the cut scores and performance

levels.

e Each ISR includes a comparison table showing the average performance of the state, district,

and/or school.

e Many ISRs include a table detailing the student’s performance in each reporting category (as in

Figure 36).

e Some ISRs include longitudinal graphs (as in Figure 37).

Figure 35. Detail of Individual Student Report (ISR): Math Interim

Jackson, Cynthia Grade 5 Mathematics - Interim (ICA) - Combined
2019-2020
Student Name: Jacksan, Cynthia | Student ID: 99996727 | Enrolied Grade: 5 TesIDISTRICT12
Date Taken: 2/27/2020 TestSCHOOLA
Achiovement Lovel: Level 4 Scale Score: 2746+58
2881
Name Average Scale Score
Level 4 exceeded and
emonstrates advanced progress foward mastery of the knowledge
Score 1 and skills in mathematics needed for likely success in future TestDISTRICT12 2716
2746 458 coursewark.
o TestSCHOOLY 2716

Level 3 The student has met the achieverment standard and

progress ige and skills
in mathematics needed for likely success in fulure coursework.

Information on Standard Error of Measurement

Level 2 The student has nearly met the achievement standard and
may require further development o demonstrate the knowledge and
skills in mathematics needed for likely success in future

coursewark

A student's score is best interpreted when recognizing
that the students knowiecge and Kills fall within &
score range and nat just a precise number. For
example, 2300 (+-10) indicates a score range
betwen 2290 and 2310.

e
Level 1 The student has not met the achievement standard and
needs substantial improvement to demonstrate the knowledge and
‘skills in mathematics needed for likely success in future
irsewark
2088

Figure 36. Detail of Individual Student Report (ISR): Math Interim with Reporting Categories

Reporting Categories

Low At or Approaching ODn or Above

The table and the graph below indicate student performance on individual claims. The black dot indicates the student’s score on each claim. The lines to the left and
right of the dot show the range of likely scores your student would receive if he or she took the test multiple times.

Category

Algebra

Functions

Numbers and Quantities

Statistics and Prabability

Performance Performance Level Performance level Description

|—.—| The student has nearly met the achievement standard

The student has nearly met the achievement standard

l—;.—' The student has nearly met the achievement standard

The student has not met the achievement standard

32



Centralized Reporting User Guide

Figure 37. Detail of Individual Student Report (ISR): Math Interim with Longitudinal Graph

Jackson, Cynthia

Grade 5 Mathematics - Interim (ICA) - Cz}ombined

019-2020
Student Name: Jackson, Cynthia | Student ID: 99996727 | Enrolled Grade: 5 TestDISTRICT12
Date Taken: 2/27/2020 TestSCHOOLY
Achievement Level: Level 4 Scale Score: 274658
Trend Report
Lagend
3000

. Level 1
2800
D Level 2
2600 :\ Level 3
. Level 4
200 |E|Sludenl Score
2200
2000
)
& &
A o
Date Test Reason Test Label Scale Score | Performance Level
8/17/2018 12:00:00 AM Unassigned Grade 3 MATH -COMBINED 2314 Level 1
2/27/2020 12:00:00 AM Unassigned Grade 5 Mathematics - Interim (ICA) - Combined 2746 Level 4

How to Generate and Export Individual Student Reports (ISRs)

To generate and export an Individual Student Report (ISR)that details a student’s performance, use the
Student Results Generator. You can select any combination of a test reason, assessments within a
subject, and students in order to generate either a single ISR or multiple ISRs at once.

You may want to use the Student Results Generator to simultaneously print large numbers of ISRs.

ISRs can be generated from almost any Centralized Reporting page.
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1. Click the Download Student Results button in the Features & Tools menu. The Student Results
Generator window opens (Figure 38).

Depending what page you open the Student Results Generator from, the options available to you
may be prepopulated or preselected; for example, the Student Portfolio Report prepopulates a
single student, and the Student Performance on Test report preselects a single test opportunity.
(The filters applied to the page have no effect, however.) You can change the selections.

Figure 38. Student Results Generator Window as Opened from Performance on Tests Report

Student Results Generator
ReporuType Search by
® Individual Student Report Student Data File Student ID nter up to 5 comma-separated student IDs Search
Report Options 9
Include anly those students who were mine when they = Select a test reason.
tested. i
2
Print Options - 20232024 - ELPA21 Screener
Report Format % Fall 2023
® Single PDF Multiple PDFs ina ZIP file §
E K2_FallFieldTest_23_24
PDF Type

) Positest
® Simple Detailed
Pretest

Spring 2024 - Alt ELPA

Spring 2024 - ELPA21 Summative

Test 1
Generate Cancel
Tast 2

2. Inthe panel on the left, select Individual Student Report. Always do this before you make other
selections. Switching between the Individual Student Report and Student Data File options may
revert some selections.

3. Optional: Select Include only those students who were mine when they tested. This setting allows
you to include students who were associated with you at the time of testing (regardless of their
current associations). If you mark this checkbox, students who were not associated with you at the
time of testing are excluded.

This option appears only if the reporting school year and time are set to the present in the Change
Reporting Time Period.

4. If you're generating multiple ISRs, then under Report Format, choose either a single PDF for all the
ISRs, or a ZIP file containing a separate PDF for each one. If you select Single PDF, the Student
Results Generator may nonetheless create a ZIP file of multiple PDFs depending on the number of
schools, grades, and opportunities included.

5. Under PDF Type, select either a simple or detailed PDF.

6. Optional: If supplemental materials are available, such as a cover page or addendum, select Include
under Supplemental Materials.
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7. If the test opportunity options are not preselected, or if you want to change them, there are two
ways to make selections:

= Search for students. In the search field at the upper-right corner, enter up to 5 comma-
separated student IDs and click Search. The resulting list of students and all the tests they've

taken will replace any previous selections, as in Figure 39. To deselect and clear results, click
Clear Search Results.

Figure 39. Student Results Generator Window: Student Search Results

Student Results Generator
Report Typs Search by
@ Individual Student Report O Student Data File Student ID Enter up to 5 comma-separated student IDs m
Report Options
Include only those students who were mine when they Select the Students. Clear Search Results
festac Last, First15 (9999988015)
Print Options Test Reasons: Winter 2024
Report Format Subjects: Science
® Single PDF Multiple PDFs in a ZIP file
PDF Type

® Simple Detailed

Language

English W

Ctlr.lce'

= Use the three accordion sections. (If a student is prepopulated by the Student Portfolio
Report, first remove the student by clicking Clear Search Results.) Starting from the left, click
the section bars to expand them or use the Next and Previous buttons to navigate. Within
each section you must make selections using the radio buttons and checkboxes:

i. Inthe Select Test Reason accordion section (Figure 40), choose a test
reason. Test reasons are either test windows or categories for tests.
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Figure 40. Student Results Generator Window: Select Test Reason Section

Student Results Generator

Report Type

@ Individual Student Report O Student Data File

Report Options:
(1 Include only those students who were mine when they
tested.

Print Options

Report Format

@ Single PDF O Multiple PDFs in a ZIP file

PDF Type

® Simple O Detailed

Cancel

Search by
Student ID Enter up to 5 comma-separated student IDs
(] ®
—~  Select atest reason. Mext 5
éu O 2023:2024 - ELPAZ1 Screener §
F-3 ® Fall 2023 &
2
§ ) K2_FallFieldTest_23_24 §
O Posttest
O Pretest
) Spring 2024 - Alt ELPA

O Spring 2024 - ELPAZ1 Summative
O Testl

0 Test2

ii. Inthe Select Assessments section (Figure 41), choose any number of tests
or grade levels within a single subject.

Figure 41. Student Results Generator Window: Select Assessments Section

Student Results Generator

Report Type

@® Individual Student Report O Student Data File

Report Options

J Include only those students who were mine when they
tested.
Print Options

Report Format

@ Single POF O Multiple PDFs in a ZIP file

PDF Type

®Simple O Detailed

Language
English v

Cancel

&8

Search by

Student ID Enterupt ma-separated stude:

® @
= [0S Select the assessments. Previous Next w
£ §
2 Q
= ~ ® Science @
2 g 4
4 § ~ @ Grade3 %
g @ ATLAS Grade 3 Science Interim

A [ Grade4

] ATLAS Grade 4 Science Interim

Grade 5

A U

] ATLAS Grade 5 Science Interim

iii. Inthe Select Students section (Figure 42), choose students from the
expandable school and/or class (roster) options. If you’re a district-level
user, you may choose students in up to three schools.
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e Sometimes the list of students is truncated. You can display the entire list by clicking
Click to Load More.

o Note that marking the checkbox for a student in one roster or school also marks it
anywhere else the student appears, and the same goes for clearing the checkbox.

Figure 42. Test Administrator-Level User View: Student Results Generator Window: Select Students

Section
Student Results Generator
Bepoct Typs Search by
@® Individual Student Report O Student Data File Student ID terupto 5 r-separated student I0s m
Report Options ® ® O
Include only those students who were mine when they S S o Select the students. Previous
tested. % § %
2 2
Print Options ol s 5 8 All Students
2 g g
Repoft Formet 2 2 3 @ Testing-2324
@ Single PDF Multiple PDFs in a ZIP file § g »
3 i + B tester
PDF Type
@ Simple Detailed 5 (Students Not In Any Roster)
Language
English v

Generate Cancel

7. Optional: If you used the accordion sections to make your selections, then to set a range of
processing dates for which to generate results, use the filter menu as follows:

a. Open the Filters menu. The menu displays two date fields, as in Figure 43.
b. Use the calendar tools to select dates, or enter them in the format mm/dd/yyyy.

c. Click Apply.

d. Optional: To revert to including results for all available dates, reopen the filter menu, click
Clear Filters, then click Apply.
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Note that processing date is not always the same as the date a test was taken.

Figure 43. Test Administrator-Level User View: Student Results Generator Window: Select Students
Section with Filter Menu Open

Student Results Generator
Report Type Search by
@® Individual Student Report O Student Data File Student ID ter up t epar tudent m
Report Options ® 0 O
Include only those students who were mine when they ~  » o Selectthe students. Provious
tested ¢ B8 &
g & g
Print Options 2 » @ @ AlStudents Cleat Filter
8 g [ Include only results reported in the followi
= a ng
Report Format 2 2 3 < Testing- date range:
@ Single PDF Multiple PDFs in a ZIP file E g -
g |ig « @ tester Start Date [}
PDF Type
@® Simple Detailed 5 (Student;  End Date [z

Language
English v Cancel
Canee!

8. From the Language drop-down list, select a language for the ISR.

9. Click Generate. Once ISR generation is finished, the File Center contains the new ISR(s) available for
download.

Note that if a student took a test multiple times with different test reasons, an ISR will be generated for
each test opportunity. If a student took a test multiple times with the same test reason, only one test
opportunity will be included. You can create an ISR for another test opportunity by navigating directly to

the report for that opportunity. Past test opportunities are marked with numbers Yin reports, starting
with the earliest.

How to Generate and Export Student Data Files
This section discusses student data files, which are useful for analysis.

To generate and export student data files for a student, use the Student Results Generator. You can
select any combination of a test reason, assessments, and students in order to generate and export the

files.

You can generate student data files from almost any report page.

1. Click the Download Student Results button in the Features & Tools menu.
2. The Student Results Generator window opens (see Figure 44).

Depending what page you open the Student Results Generator from, the options available to you
may be prepopulated or preselected; for example, the Student Portfolio Report prepopulates a
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single student, and the Student Performance on Test report preselects a single test opportunity.

(The filters applied to the page have no effect.) You can change the selections.

3. Inthe panel on the left, select Student Data File, as in Figure 58. Always do this before you make
other selections. Switching between the Individual Student Report and Student Data File options

may revert some selections.

Figure 44. Student Results Generator Window

Student Results Generator

Report Type

Individual Student Report  ® Student Data File

Report Options

Include only those students who were mine when they

tested.
Print Options

Report Format
@ XLS C8V TXT

Output

@® Data File for Each Test Single Combined Data File

Search by

Student ID

Q

- Select a test reason.

(7]

5

2

= 2023-2024 - ELPAZ1 Screener
w

2 Fall 2023

[}

% K2_FallFieldTes1_23_24

Posttest

Pretest

Spring 2024 - Alt ELPA

Spring 2024 - ELPA21 Summative
Test1

Test2

Test 3

Unassigned

4. Optional: Select Include only those students who were mine when they tested. This setting allows
you to include students who were associated with you at the time of testing (regardless of their
current associations). If you mark this checkbox, students who were not associated with you at the

time of testing are excluded.

This option appears only if the reporting school year and time are set to the present in Change

Reporting Time Period.

5. Under Report Format, select XLS (Excel .xlsx), CSV (comma-separated values), or TXT (tab-delimited

text).

6. Under Output, select either Data File for Each Test or Single Combined Data File. Note that a single

combined file does not include reporting categories. Large files may be split by school.
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7. If the test opportunity options are not preselected, or if you want to change them, there are two
ways to make selections:

= Search for students. In the search field at the upper-right corner, enter up to 5 comma-
separated student IDs and click Search. The resulting list of students and all the tests they’ve
taken will replace any previous selections, as in Figure 45. To deselect and clear results, click
Clear Search Results.

Figure 45. District-Level User View: Student Results Generator Window: Student Search Results

Student Results Generator
Report TyF Search by
Individual Student Report @& Student Data File Student ID Enter up to 5 comma-separated student IL m
Report Options
Include only those students who were mine when they Select the Students. Clear Search Results
G Last, First15 (3999988015)
Print Options Test Reasons: Winter 2024
Report Format Subjects: Science
® XLS csv TXT
Output

@ Data File for Each Test Single Combined Data File

= Use the three accordion sections. (If a student is prepopulated by the Student Portfolio
Report, first remove the student by clicking Clear Search Results.) Starting from the left, click
the section bars to expand them or use the Next and Previous buttons to navigate. Within
each section you must make selections using the radio buttons and checkboxes:

i. Inthe Select Test Reason section (Figure 46), choose a test reason. Test
reasons are either test windows or categories for tests.
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Figure 46. Student Results Generator Window: Select Test Reason Section

Student Results Generator
FoputTYpe Search by
O Individual Student Report @ Student Data File Student ID m
Report Options Q e
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tested. g %
2
I Opthony = ) 2023-2024- ELPA21 Screener §
2
Report Format E @® Fall 2023
@XS OCSV  OTXT & §
5 ) K2_FallFieldTest_23_24 F
Output .
P O Posttest

@ Data File for Each Test O Single Combined Data File
S O Pretest

) Spring 2024 - Alt ELPA
O Spring 2024 - ELPA21 Summative
) Test1

0 Test2

O Test
Generate Cancel ) Test3
) Unassigned

ii. The Select Assessments section (Figure 47) groups tests by subject and
grade. Mark the checkboxes beside the tests or groups of tests you want to
include in the report, or mark All Subjects.

Figure 47. Student Results Generator Window: Select Assessments Section

Student Results Generator

Report Type Search by
~ Individual Student Repert @ Student Data File Student ID m
Report Options ® 0 ®
(] Include only those students who were mine when they ~ Select the assessments. Previous Next -
tested. @
§ § All Subjects 3
Print Options 5 E 5
Report Format ; ~ & Science §
@XS OCsV  OTXT g 5 B Grade3 ®
@ 3
Output ATLAS Grade 3 Science Interim
@ Data File for Each Test ) Single Combined Data File
2 ’ - Grade 4

ATLAS Grade 4 Science Interim
~ Grade 5

ATLAS Grade 5 Science Interim

m Cancel - Grade &

W AT A e £ i At

iii. Inthe Select Students section (Figure 48), select any number of students
from the expandable school and/or roster options.

e Sometimes a list of students is truncated. You can display the entire list

by clicking Click to Load More.
e Marking the checkbox for a student in one roster or school also marks it
anywhere else the student appears, and the same goes for clearing the

checkbox.
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Figure 48. School-Level User View: Student Results Generator Window: Select Students Section

Student Results Generator
LSTUngD Search by
Individual Student Report @ Student Data File Student ID Entter up tc mma-separated studer
Report Options o0 0
Include only those students who were mine when they ~ p w Selectthe students. Previous
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2 3
Print Options :._; % é B Al Students
i3 g
LR z 8 v Testing - 23-24
@ XLS csv TXT g =
S ot 2 e o O tester
Output o {Students Mot In Any Roster)

@ Data File for Each Test Single Combined Data File

Generate Cancel

7. Optional: If you used the accordion sections to make your selections, then to set a range of
processing dates for which to generate results, use the filter menu as follows:

Open the Filters menu (see Figure 49). The menu displays two date fields.

o

b. Use the calendar tools to select dates, or enter them in the format mm/dd/yyyy.

c. Click Apply.

d. Optional: To revert to including results for all available dates, reopen the filter menu, click
Clear Filters, then click Apply.

Note that processing date is not always the same as the date a test was taken.
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Figure 49. School-Level User View: Student Results Generator Window: Select Students Section with
Filter Menu Open

Student Results Generator
oportType Search by
Individual Student Report @ Student Data File Student ID Enter up to 5 comma-separated student IDs
Report Options o0 O
Include only those students who were mine when they ~  pa w Selectthe students. Previous
tested. 2 el ¢
2 2
Print Options :'_; % é 2 Al Students
@ E Include only results reported in the following
I E T @ Testing- daterange:
® XLS csv TXT § =
Al selected asses H & . tester Start Date i)
Output [ (Student EndDate i
@® Data File for Each Test Single Combined Data File
in s Apply Cancel

8. Click Generate. Once data file generation is finished, the Secure File Center contains the new
student data file(s) available for download.

Note that if a student took a test multiple times, the files will include each test opportunity.

How to Compare Students’ Data with Data for Your State, District, School,
and/or Total Students

In the Performance on Tests report and the Student Portfolio Report, you can access performance data
for your state, district, school, and/or total students.
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How to Compare All Your Students’ Performance on Any Test with Larger Groups

In the Performance on Tests report (see Figure 50), click s+ to the right of a test name.

Figure 50. Teacher View: Performance on Tests Report

Select Role » Dashboard Generator * Dashboard » Performance on Tests Enter Student ID Q,
o asn
- # My Assessments iii Features & Tools

Average Score and Performance Distribution, by Assessment: All Rosters, 2022-2023
Filtered By Rosters: All Roster | Test Reasons: All Test Reasons |

Groups Student Average Date Last
Assessment Name Test Group Test Grade Test Reason Count 5 Tak -

= .
Eél &, Test 547498 Math 1/1 Test Authoring 6 Unassigned 1 0% @ 01/19/2023
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&, Test 547499 Science 1/19 “ | Test Authoring 4 Unassigned 1 7= 0 01/19/2023
Raosters

&, Test 546817 WV 1/17 "  Test Authoring 6 Summer 2023 1 0% @ 0117/2023

Rows perpage: 3 O S ltems: 1 of2 >

A My Students

Most Recent Assessment of All Rosters: 2022-2023
Filtered By Rosters: All Roster | Test Reasons: All Test Reasons |

Student Name Student ID Most Recent Assessment Date Taken
Test Test 716623001 Test 547498 Math 1119 011972023
Rows perpage: | 6 O 1 ems: 1 of1

Rows containing data for the state, district, and/or school appear below, as in Figure 51.

Figure 51. Teacher View: Performance on Tests Report with Expanded Comparison Rows

Seect Aoke ¥ Dashboard Generalor ¥ Dastboad » Performance on Tedts ey St =

-
2= A My Aaseasments 11 Features £ Tools
)

Awerage Score and Performance Distribution, by Assessment: All Rosters, 2022-2023

(L et By Mustars A0 Buster | Tasn Bowsiaa: Al Test Ressons
. Assessment Hame Test Group Test Grude Test Reason Student Count Average Soone DateLust Taken 5
Eﬂ &, TEaLSAT498 Mat 1719 ~ T Aisthasting [ Unagssgned 1 [N ] LETRLTrivs]
Tem
[
Stale Teid S4T408 Math 1119 Tedd Autharing & Unassgned nfa na —
g
Dt Test S47498 Math 1719 Test duthaing [ Unassgned 1 @ -
School  Tess S47408 Math 1719 Tean Autharing [ Urassgred i "o -
& TestS474%3 Scence 1019 w Test Autheing 4 Unassigned 1 o ] s
& TesUSeEL2 WY 147 w Test Autharing & Summer 123 1 ) NN

Porws por page: 3 4 merns: 1 e}

To hide the comparison rows, click » to the right of the test name.
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How to Compare a Student’s Performance on Any of Their Tests with Larger Groups

In the Student Portfolio Report, you can compare a student’s performance on any test with that of your
state, district, school, and/or total students.

1. Enter the student's WISER ID in the search field in the upper-right corner and click the search
button. (When you are viewing the Dashboard Generator and data are available, the same field
appears to the right of the dashboard generation controls.) The Student Portfolio Report appears.

Teachers can also access this report from the Performance on Tests report by going to the My
Students table at the bottom of the page and clicking a student's name.

2. Click s to the right of a test name (see Figure 52).

Figure 52. Student Portfolio Report
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a= Score and Performance, by Assessment and Test Reason: Test Test, 2022-2023 3 Features & Tools
Filters

Student

= Asseszment Name Test Group Test Grade Test Reason Count Score Date Taken «
(1]

TO:;
Groge Tesi 547498 Maih 1/19 Test Autharing [ Unassigned 1 123 01/19/2023
Test 547499 Science 1/19 W Test Authoring 4 Unassigned 1 ™ 011972023
School

Wi

Tiest S47406 ELA 1119 W Test Authoring 3 Unassigned 1 % o023
Riows per page: 3 6 ltems: 1 of2 »

Rows containing data for your state, district, school, and/or total students appear below, as in Figure 53.

Figure 53. Student Portfolio Report with Expanded Comparison Rows

Select Role » Dashboard Generatgr » Dashboard * Student Portfolio nter Student Q
~
— ; ; . .
= Score and Performance, by Assessment and Test Reason: Test Test, 2022-2023 12 Features & Tools
Finars
Student
- Assessment Name Test Group Test Grade Test Reason s Score Date Taken «
— Test 547498 Math 1/19 A Test Authoring & Unassigred 1 % 0111972023
State  Test 547498 Math 1/19 Test Authoring & Unassigned nfa nia -
Schaol
Vi
District  Test 547458 Math 1119 Tesi Authering [} Unassigned 1 s @ -
School  Test 547498 Math 1,19 Test Authoeing 6 Unaszigned 1 [ ] -
MY Test 547498 Math 1119 Test Authorin [ Unassigned 1 [N ] -
Students o 9 Ms g
Test 547499 Science 1/19 s Test Authoring 4 Unassigned 1 ™ 01/19/2023
Test 547496 ELA 1119 | Test Authering 3 Unassigned 1 o 01952023
Rows per page: 3 & llems: 1 of2 3

To hide the comparison rows, click 4 to the right of the test name.
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Section lll. How to Set Up Your Reports for Summatives and
Interims to Suit Your Needs

You can set up your reports so it’s easier to access the data that are most important to you. For
example, if you’re a teacher, you may want to hide certain tests in subjects you don’t teach, or you may
want to narrow down your reports to a single roster.

This section explains how to make several different adjustments to reports: filtering to show only the
tests you're interested in; filtering to show only the rosters you’re interested in; showing only the
schools you’re interested in; and viewing data from a previous point in time.

How to Filter Tests to Display

You can temporarily filter which tests you want to see in your reports. You may want to do this, for
example, if you are an ELA teacher and you don’t want to see your students’ math scores. By default,
the data for those math assessments appear in your reports.

Filtering tests to display begins on the Dashboard Generator page. This is where you can select the test
groups you want to view on the dashboard and, as an option, set those selections as defaults. You can
also temporarily filter the tests that appear in the reports you are currently viewing, as described below.

1. Onthe left side of the dashboard or the Performance on Tests report, click the Test Groups button.
The Filters panel expands (Figure 54).

2. Mark as many selections as you like in the Test Groups section of the filters panel (Figure 54). Tests
are organized by test type, subject, and grade.

Figure 54. District-Level User View: Dashboard with Expanded Filters Panel
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3. Click Apply. The report updates to show only data for those tests.

4. Optional: To revert all filters to their defaults, open the filters panel again and click Clear Filters.
Click Apply. Filters also revert when you log out, switch user roles, or switch systems.
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For Teachers and School-Level Users: How to Filter Rosters to Display

Rosters usually represent classes, but can represent any group that’s meaningful to users, such as
students who have taken honors courses. Each roster is associated with a teacher. To learn how to
create and modify rosters in Centralized Reporting, see Class (Roster) Management.

In the Performance on Tests report, teachers and school-level users can filter by a particular roster.
When you filter, you eliminate students not in the selected class from the data you’re viewing.

Filtering by roster makes it easy to focus on the performance of a particular class. By switching filters,
you can easily compare one class to another. If you don't filter by roster, the reports default to showing
data for all classes. You may find data for a single class easier to understand.

1. Onthe left side of the Performance on Tests report, click the Rosters button. The Filters panel
expands (Figure 55).

2. Make a selection from the drop-down list in the Rosters section.

= Ifyou’re a school-level user, you must first select a teacher from the drop-down list, and then
select a particular roster from the second drop-down list that appears. By default, the first
class listed is selected.

Figure 55. Teacher View: Performance on Tests Report with Expanded Filters Panel

Select Role » Dashboard Generator » Dashboard * Performance on Tests ter Student Q
—
Filters 35 A My hssessments i3 Features & Tools
= N Awverage Score and Performance Distribution, by Assessment: Test_roster_MonProctored,
[E5L, ~ TestGroups 2022-2023
Fitered By Rosters: Test_roster NonProciored | Test Reascns: AN Test Reasons
R ~ TestReasons Test Student A Date Last
I verage
Asgessment Hame Test Group Test Grade R © 5 Taken
~ Foslers T [ . Test
&, Tes1 547498 Math 1119 ~ r [ Unassigned 1 o @ 01/15/2023
- Autharing "9
All Rosters w
&, Tesi547499 Science 1719 v nu:hfr‘.ng 4 Unassigned 1 7 @ 0171972023
e AR w1 Test Summer " ’
& Tesi 546812 W 1017 ¥ puthoring [ 202 1 0% @ 017172023
Rows per page: 3 5 Items: 1 of2 ¥
# My Students
Most Recent Assessment of Test_roster_NonProctored: 2022-2023
Fitered By Rosters: Test_roster NonProctoned | Test Reasons: AN Test Reasons
Chear Filters

Student Narme Student ID Most Recent Assessment Date Taken «

-‘” Tes, Test 716623001 Test 547498 Math 1119 01/1%/2023

3. Click Apply. The report updates to show only data for that roster.

4. Optional: To revert all filters to their defaults, open the filters panel again and click Clear Filters.
Click Apply. Filters also revert when you log out, switch user roles, or switch systems.

All the reports accessible from this page will be filtered the same way.
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The row of filter details below each table header shows the rosters you’re viewing (see Figure 73).

For District-Level Users: How to Filter Schools to Display

Filtering the Performance on Tests report by school makes it easy to focus on a particular school’s
performance. By switching filters, you can easily compare it with another school. If you don’t filter by
school, the Performance on Tests report defaults to showing data for all schools. You may find data for a
single school easier to understand.

1. Onthe left side of the Performance on Tests report, click the Schools button. The Filters panel
expands (Figure 56).

2. Make a selection from the drop-down list in the Schools section (see Figure 56).

Figure 56. District-Level User View: Performance on Tests Report with Expanded Filters Panel

Select Role > Dashboard Generator > Dashboard > Performance on Tests ter St t Q
e ;
Filters M Average Score and Performance Distribution, by Assessment: Demodistrict9996, 2022-2023 HH
- 9 iii Features & Tools
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3. Click Apply. The report updates to show only data for that school.

4. Optional: To revert all filters to their defaults, open the filters panel again and click Clear Filters.
Click Apply. Filters also revert when you log out, switch user roles, or switch systems.

If you click the name of a test when you've filtered by a single school, the link will take you to the School
Performance on Test report and not to the District Performance on Test report.

The row of filter details below the table header shows the schools you’re viewing.
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How to View Data from a Previous Point in Time

Changing the reporting time period allows you to view test results from a previous point in time. There
are two time-period settings:

e When you set a school year for which to view tests, the reports show data for test opportunities
completed in the selected school year.

® \When you set a date for which to view students, the reports show data only for the students who
were associated with you on the selected date and only for tests taken as of that same date.
Students’ enrollment and demographic information is all given as of the selected date as well. You
can use this setting to view data for students who have left or recently entered your classes
(rosters), school, or district. You can even view students who have left your state.

If you don’t change the reporting time period, or if you reset it to the default, all the reports show test
opportunities only for the current school year (except Longitudinal Reports and Student Portfolio
Reports, which always retain the ability to look back to previous years), with current student data.

Some examples of how you can use this feature:
e You may want to view the past performance of your current students, including new transfer

students. In that case, set a school year in the past and keep the date set to today.

e You may want to view the past performance of your former students in order to compare them with
that of your current students. In that case, set the date to a time when your former students
belonged to you and had tested, and set the school year to the same time. Then switch back to the
present to compare.

1. From the Features & Tools menu, select Change Reporting Time Period. (If you're viewing the
Dashboard Generator page, click Change the reporting time period. The dashboard also offers this
link when no assessments are available to display.) The Change Reporting Time Period window

appears (Figure 57).

Figure 57. Change Reporting Time Period Window

Change Reporting Time Period

View results for school year:  2023-2024 ~

View results for students who were mine on: ~ 07/20/2023 ﬁ

Mote: All dates are in Eastern Time Reset To Today

2. From the school year drop-down list, select a school year (see Figure 57). This is the year for which
you will view test results.
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3. Inthe View results for students who were mine on field, use the calendar tool to select a date, or
enter it in the format mm/dd/yyyy. You will be viewing all the students who were associated with
you and had tested on that date, and only those students.

= Toview your current students’ past performance, keep the date set to today.

= Toview the past performance of your former students, set the date to a day when those
students were associated with you and had tested.

4. Click Save. All reports are now filtered to show only data for the selected school year and date. All
other filters are cleared.

5. Optional: To go back to viewing the latest data, open the Change Reporting Time Period window
again, click Reset To Today in the lower-right corner, then click Save. The date resets and all filters
are cleared. The reporting time period also resets when you log out, but persists when you switch
roles.

50



Centralized Reporting User Guide

Section IV. How to Export and Print Data

You can export or print any data you see in Centralized Reporting. Some can be exported directly from
the Performance on Tests report. You may want to export or print to save a snapshot of data to consult
later, or to share data. Different options will be available depending on the report you are viewing.

How to Export or Print a Report You’re Viewing

1.

Select the print button from the Features & Tools menu, or, in some reports, from the upper-right
corner. If there are multiple report tables on the page, multiple print buttons appear.

A print preview page opens (see Figure 58).

= Tozoom in on the print preview, use the drop-down list under the Zoom Level (Display only)
section. This setting affects the preview only.

Figure 58. Print Preview Page
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2. If an aggregate report provides data for individual items, the Report Options section appears. Select
either Summary Only or Summary and Item Scores. If you select the latter option, as in Figure 59,
the printed report includes data for the individual assessment items. Printouts of the Student
Performance on Test report always include item data if available.

Figure 59. Print Preview Page with Summary and ltem Scores Option Selected
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o .
® Print
e "
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Save to PDF

Save 1o Excel
Save to CSV
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Confirm | Cancel |

3. To print the report, select the Print radio button. To download it, select Save to PDF, Save to Excel
(XLSX), or Save to CSV (comma-separated values).

5. Optional: If a printout or PDF is for a particular student and the report includes items, you
can mark the Include Items and Responses (takes extra time) checkbox. The resulting report

includes the actual items and the student’s responses.

6. If you selected Save to PDF, choose an option from the Page Layout drop-down list that

appears.

4. Click Confirm.

If you saved the report as a PDF, Excel, or CSV, the Secure File Center window appears, displaying the

generated report.
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How to Export an Assessment Report Directly from the Performance on
Tests Report

1. Click .i. to the left of the name of the assessment whose report you wish to export (see Figure 60).

Figure 60. Teacher View: Performance on Tests Report

Select Role » Dashboard Generator » Dashboard » Performance on Tests

= # My Assessments i Features & Tools
Fihers
Average Score and Performance Distribution, by Assessment: All Rosters, 2022-2023
f_ Filtered By Rosters: All Rosier | Test Reasons: All Test Reasons |
an
Test
Groups Student Average Date Last
Assessment Name Test Group Test Grade Test Reason Count 5 Taken -
'f_'é Test 547498 Math 119 »  Test Authoring ] Unassigned 1 0% @ 01/19/2023
i
nlr:wnl
&, | Test 547499 Science 1/19 “  Test Authoring 4 Unassigned 1 ™0 01/19/2023
Rosters
&, Test 546812 WW 1/17 w  Test Authoring ] Summer 2023 1 0% @ 01/17/2023
Rows per page: 3 5 ltems: 1 of2 »
A My Students
Most Recent Assessment of All Rosters: 2022-2023
Filtered By Rosters: All Rosier | Test Reasons: All Test Reasons |
Student Name Student ID Mast Recent Assessment Date Taken
Test, Test 716623000 Test 547498 Math 1/19 01/19/2023
Rows per page: | & 1 ltems: 1 of1

The Export Report window opens. The options in this window vary according to your user role.
2. Select which report to export for the assessment.

7. District-level users:

To export the district test results, mark the Overall Performance of all my Schools radio
button.

To export school test results (excluding data for individual items), mark the Overall Test

& Reporting Category Performance of all my Students for [School Name] radio button,
then select a school from the drop-down list.

To export school test results (including data for individual items), mark the Overall Test,
Reporting Category and Item Performance of all my Students for [School Name] radio
button, then select a school from the drop-down list.
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Figure 61. District-Level User View: Export Report Window

Export Report for Summative Grade 3 MATH

Choose Type of Report

1.  ® Overall Performance of all my Schools

© Overall Test, Reporting Category Performance of all students

Select School ~

Select Export File Type
2. @®PDF OExcel OCSV

Export Assessment Data

8. School-level users and teachers:

— To export results for all your associated students (excluding data for individual items),
mark the Overall Test, Reporting Category Performance of all students. radio button.

— To export results for all your associated students (including data for individual items),

mark the Overall Test, Reporting Category and Item Performance of all students. radio
button.

Figure 62. Teacher View: Export Report Window

Export Report for Test 547498 Math 1/19

Choose Type of Report

1.  ® Overall Test, Reporting Category Performance of all students
© Overall Test, Reporting Category and Item Performance of all students
Select Export File Type

2. ®@PDF OExcel OCSV

Export Assessment Data

3. Choose from the PDF, Excel, and CSV formats.
4. Click Export Assessment Data. A confirmation window appears.

Click Yes to export or No to return to the Export Report window. When you’ve exported a file, the
Secure File Center window appears with the generated file available for download.

This section explains Centralized Reporting features and functions that are specific to interim, modular,

and teacher authored tests assessment reports. These features cannot be used with summative
assessment reports.
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How to Access Item-Level Data

Reports for individual interim, modular tests, and teacher authored tests include the following:

e [tem-level data.

® Access to the items themselves. (Modular and Teacher-Authored tests)

® Access to student responses to the items. (Modular and Teacher-Authored tests)

Test results for adaptive interim assessments include item-level data only on the individual student
level. The item-level data for interim assessments will not include the ability to view the items or
student responses.

How to View Item Scores

To expand sections containing item data, click the vertical section bars as in Figure 63.

Figure 63. My Students' Performance on Test Report: Performance by Student Tab with Expanded
Reporting Category Section

Select Bole > Dashbond Generier > Dashonged » Perlormance oo Tests > Sehosl Performance on Test Q
Performance by Roster y 15 Foatures & Tooks

[®)  Average Score, Performance Distribution and Average Points Exned on FF-CIA Grade 6 Math (151 opportunity), by Roster and Reporting Category: Demo Schoal 999801 2022.2023
Senduds Fherec By Rosters: A Roster | Test Reasons: 15t coportanty | Standasds Keys

Roster Teacher (ol )
© 000
g 5 § e Numbers and Poiats Eamed
§ £ Performance Destrbuton
3 é g [ p " " " ] gt 2 " " i
2
; 48 . .
£ 2
(o)
11 o ; s | 5
2R -
I vz °
School Y 0 0 0 o 1

Rows perpege 30 1 ems 1o

55



Centralized Reporting User Guide

How to Find Out Which ltems Students Performed on the Best or Struggled with the
Most

Look in the sections 5 Items on Which Students Performed the Best and 5 Items on Which Students
Performed the Worst (see Figure 64). You can click the vertical section bars to expand them, just like
other sections.

Figure 64. School Performance on Test Report: Performance by Student Tab with Expanded 5 Items on
Which Students Performed the Best and Worst Sections
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How to View Standards for Each ltem

In a report displaying item-level data, you can view the standard or standards to which each item is
aligned. This allows you to determine at a glance what the item measures.

To show and hide item standards, click the Standards Keys toggle ~ ™ in the row of filter details
below the report table heading. Under each item number appears a standard key or list of standard keys
(see Figure 65). Note, on fixed-form assessments, the Standards Key toggle is available at the district,
school, roster, and student level. For adaptive assessments, the toggle is available at the student level.

Figure 65. School Performance on Test Report with Expanded Reporting Category Section
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Click the more information buttons @ beside the standard keys to view legends displaying the full text
of each cluster (category of standards) and each standard, as in Figure 66. This full text is not included in
printouts or exports.

Figure 66. School Performance on Test Report with Expanded Reporting Category Section and
Expanded Legend
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How to View an ltem
For modular and teacher authored tests you can view the actual items themselves, along with student
responses to those items.

Do either of the following (see Figure 86):

e Toview the item in a blank state, click the item number in the first row of the report table.

e Toview the student’s response to the item, find that student’s name in the Student column on the
left. Then click the score the student obtained on that item.

The Item View window appears (see Figure 67). It contains an Item & Score tab and a Rubric &
Resources tab. A banner at the top of the window displays the item’s number, score (when the item
includes the student’s response), and confidence level (when a machine-suggested score has a low
confidence level). The Item & Score tab (see Figure 67) shows the item and may include a particular
student’s response.

Figure 67. Item View Window: Item & Score Tab with Student Response (Item Redacted)

FF-CIA Grade 6 Math
€ mem 36 Student: LASTI7E, Firs1 778 ibeen &0 3
Current Itemc 37 Scone 11 Item & Score Rubsic & Rescurces
Scoring Assertion Outcome
1. Comect answer L4

hem Language: English ~

student BetinglE)

Usee the expression to anawer the question.

4 A

Iltem Content
Redacted

\ J

The Item & Score tab may include the following sections.

e Scoring Criteria: When you’re viewing a student’s response and the item has scoring criteria, the
Scoring Criteria table (shown in Figure 68) lists the name, maximum points, points earned, and
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condition codes for each scoring criterion. This table also allows you to modify scores for items with
editable scores.

Figure 68. Iltem View Window: Item & Score Tab with Student Response and Scoring Criteria Table

CA-CIA Grade 8 ELA
£ menas Stsdent  LAST2011, Firet2011 3
Current Ibem: 28 Soore: 410 fem & Soore Fubric & Resources
Scoring Criteria Max Points Paints Earned Condition Code
CONVENTIONS 2 2 Nane
ELABORATION 4 1 ra None
ORGANLZATION 4 1 HNane
Scoring Note
User Date L
+ Add Mare
Hem Language:  English
P efIngly]
Memory “ m -

e Scoring Assertion: Each scoring assertion contains both a statement that provides information
about what the student did in their response, and the content knowledge, skill, or ability that is
evidenced by their response. When you’re viewing a student’s response and the item has scoring
assertions, the Scoring Assertion table appears, listing each assertion and outcome (see Figure 67).
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e Item: Displays the item as it appeared on the assessment in the Student Testing Site. For items
associated with a passage, the passage also appears.

o The Rubric & Resources tab (see Figure 69) include the following sections, which you can expand
and collapse by clicking s~ and A, respectively.

Figure 69. Item View Window: Rubric & Resources Tab

CA-CIA Grade 8 ELA
< mem2s Student  LAST2011, First2011
Current item: 28 Score: 4/10 Hem & Score Rubric & Resources
A Details
Topic Writing and Language Content Alignment Domain: W Writing Standards
Standards Cluster. WiB. TTP. Text Types and Purposes
Standard: W18 TTPIELA.8.210: Write informative/explanatory texts 10 examine a topic and convey ideas, concepts, and
Information through the selection, organization, and analysis of relevant content. Introduce a topic clearly, previewing what is to

fo

charts or tables), and multimedia when useful 10 aid comprehension

ow, Organize ideas, concepts, and information into broader categories; Include formatting (.9, headings), graphics (e.g

A Rubric

Statement of Purpose/Focus and Organization
The response Is fully sustained and consistently and purposefully focused.

« controlling idea or main idea of a topic is focused, clearty stated, and strongly maintained
« controlling ldea of main ides of a topic is introduced and communicated clearly within the purpose, audience, and task

The response has a clear and effective ceganizational structire cresting unity and completeness:

e Details: May provide the following information:

=  Topic: Skill area to which the item belongs.
= Difficulty: Indicates whether the item is intended to be easy, moderate, or difficult.
= Content Alignment: Describes the standard to which the item is aligned.

® Resources: Provides links to any exemplars or training guides available for the item.

e Rubric: Displays the criteria used to score the item. This section may also include a score
breakdown, a human-readable rubric, or an exemplar, which provides an example of a response for
each point value.

e Frequency Distribution of Student Responses: The table in this section provides a breakdown of
how many students in the school earned each possible point value available for a fixed-form test
item.

How to View Items With and Without the Students’ Visual Settings

When viewing items with students’ responses, you may or may not want to see the items exactly the
way the students saw them on the test. For example, some students’ tests are set to use large fonts,
different color contrast, or Spanish.
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1. From the Features & Tools menu, select Set Student Setting on Item View. The Set Student Setting
on Item View window appears.

2. Select Yes to show students’ visual settings on all items or No to hide them.
3. Click Save.

You can also show or hide visual settings on a per-item basis. To do so, click the toggle at the upper right
of the item you’re viewing. This action has no effect on your global setting.

How to Navigate to Other Items from the Item View Window

Use the navigation buttons labeled with the previous and next item numbers at the upper corners of the
Item View window.

How to View Another Student's Response to the Current ltem

If you have accessed the student’s response from a report showing multiple students, you can click the

Demo Student

| "
arrows beside the Student field | - I at the top of the window. The students are listed in the
same order in which they are sorted in the report.
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What It Means When Items Are Labeled “1-1”, “1-2”, and So On

Those are sub-items belonging to an item cluster. Clusters are broken down into sub-items because they
have multiple scoring assertions. Each sub-item has its own column to the right of the main item
column. Sub-items are labeled “[item number]-[sub-item number]”, for example, “1-1”, “1-2”, “1-3”, as

in Figure 70.

Figure 70. School Performance on Test Report: Performance by Student Tab with Expanded Total Items

Section
Select Bole > Dashboard Generator » fashboard » Performance on Tests » School Performance on Test Enter Student ID Q,
~
:M': Perfor : by Roster || Performance by Student 11t Features & Tools

@ Seore, Performance and Paints Earned on Interim MS Earth and Space Science - 5.7.ESS.4 (15t opportunity) of All Resters, by Student and
Reporting Category: Demo School 999801, 2022-2023
Fiitered By Rosbers: AN Roster | Test Reasons: 15t cpportunity | Standards Keys @l

s+ suone - 0 [ ©
g

Itern Mumbers, Max Points and Points Eamed

LM BI0L

1
S NGSSMS- 11 12 13 14 15

L]
ESSIESS1|MS-ESS1-4 2 e lml et | aats
spt

State n/a a nfa na nfa na na
District 25 9 2 1 [1} 1 o 0

Schaol 25 @ 2 1 o 1 (] ]

LAST1203, First]1 203 555501203 55 @ 2 1 o 1 o o

Rows per page: 10 = 1 Hems: 1 of1 v

To view a scoring assertion, click the more information button @ to the right of the sub-item number,
asin Figure 71.

Figure 71. My Students' Performance on Test Report: Performance by Student Tab with Expanded Total
Items Section and Sub-Item Assertion

Dashboard Generator 3 Dashboard 3» Performance on Tests » My Performance on Test Enter Student ID Q\

4|> BEE Features & Took

Filters Performance by Roster || Performance by Student LU

’-T- Average Scere, Performance Distribution and Average Points Earned on Modular: Science - Elementary Schoel Earth
Standards Space Science - Earth's Systems 1 (2019-2020 Year), by Roster and Reporting Category: 2018-2020

Filtered By Rosters: All Roster Test Reason: 2019-2020 Year  Standards Keys - mm

e+ o o
4 o
g g
S0 Item Numbers and Points Earned
F] 1 1-1 12 ° 13 ° 14 o 15 o 16 °
6 ot 1pt 1pt 1pt 1pt 1pt 1 pt
= The student varied the amount of grass and P 7 P i i
tate kept the amount of water constant, providing na na na nfa na
'some evidence of the ability to make and
o record observations while using fair tests in
District which variables are controlled 0 (e 0 Q Q
School 033 (1] 0 0.33 0 0 0
My Students 0 (] 0 0 0 0 0
@, (Students Notin Any Ro 0 0 0 ] ] [ [
@, _ProctorsRoster-1 0 0 0 0 0 0 0
Rows per page: | 9 2 ltems: 1 |of1
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What It Means When an ltem Score Reads “n/a”

You may sometimes see “n/a” instead of a score for an item. In some cases, the student did not respond
to the item, or the item was not included in that form of the test.

How to Score Items on Teacher-Authored Tests

The Centralized Reporting allows authorized users to score certain items on Teacher-Authored Tests
(TAT).

® Teacher-Authored items that require hand scoring arrive in Centralized Reporting without any
scores. For example, all short answer items, including field-authored ones, require hand
scoring. If a Teacher-Authored test contains unscored items, its performance data are excluded
from your reports until an authorized user scores all the unscored items in at least one
opportunity of that test.

How to Score Unscored ltems

For a student’s test performance to be reported, you need to enter scores for any hand-scored item
responses on that Teacher-Authored test.

When you have Teacher-Authored tests with unscored items, a Tests To Score notification appears in
the banner.

Figure 72. Banner with Tests To Score Notification

Centralized Reporting v

WYOMING Reporting User: kimberty water@cambiumassessment com | Role: STATE @ State: Wyoring
DEPARTMENT OF ECUCATION

&, Inbox @ Help [ Sign Out

Dashboard Selector » Dashboard Generator » Dashboard » Performance on Tests nter Stud Q

1. Inthe banner, click Tests To Score.
2. If the Select School page appears, make a selection and click Continue.

3. Onthe scoring Dashboard (Figure 73) click the name of the Teacher-Authored test you wish to
score. The Test Scoring page appears (Figure 74), displaying a list of students and items awaiting
scoring for the selected test. This table only includes assessments completed by students in your
rosters or students in your test sessions.
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Figure 73. Scoring Dashboard

Change Schoal
Assessments 1o score for All Rosters, 2022-2023

ASSEELTIN Naiw Tast Redson Shadent Count It to Score Tems 1o Submit Dt Lait Thkin -
|NTERIM: HS-ELA-FocusedIlAB-WrileReviseExplanaiory SchoclDistrict Cormersation i i 1] 0732003
INTERIM: GS-ELA-FocusediiB-WiitefeviseNamthes Schocl/Tistrict Cormrsation 1 1 o 7132023
|NTERIM: GE-ELA-Focusediad-WriteReyviseinamational School/District Corrversation 2 o 032023
|NTERIM: G3-Math-\AB-PTOdemFom Schocl/District Cormersation 4 o 07072023
|NTERIM: GE-ELA-Focusedinf-WiteReviselsqumnentalive SchoclDistrict Corersalion 4 1] ONOTI20T3
IKTERIN: GRELAICACAT Classneom 1 3 o 12022
INTERIME G11-ELAICAPT Classfeam 1 1 1 12022
INTERINE G11-ELAACA-CAT Classoom 1 3 ] 102022
INTERINE G1O-ELA/ICA-PT Classnoom 1 1 1 12022
INTERINE GIO-ELACA-CAT Classrcom 1 2 1 102022
Riows per page: 100 10 nems: 1 a1

Figure 74. Test Scoring Page

Dashboard > Test Scoring

Change School
INTERIM: HS-ELA-FocusedIAB-WriteReviseExplanatory (School/District Conversation) to score for Demo

inst 9999, 2022-2023
Submit Student v StudentID Date Taken Items to Score
Item Numbers and Max Points
3
2pt
Firstnm, Lastnm 1111222315  7/13/2023 4:30:00 PM Score
Rows perpage: 16 ° 1ltems: < 1 of1

Submit Score(s)

4. To enter scores for a Teacher-Authored item response, click the Score link or the score number link
for the required item in the required student’s row. The scoring window opens to the Item & Score
tab.

5. Optional: You can open the Rubric & Resources tab (Figure 75) to review the item’s scoring rubric
and any other available resources, such as an exemplar and training guide for scoring the item.
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Figure 75. Item View Window: Rubric & Resources Tab

CA-CIA Grade 8 ELA
< mem25 Student  LAST2011, First2011 >
Current Item: 28 Score: 4/10 ftem & Score Rubric & Resources
A Details
Topic Writing and Language Content Alignment Domain: W: Writing Standards
Standards Cluster: WIB.TTP. Text Types and Purposes

Standard: WIS TTHELA.8.21a: Write informative/explanatory texts 10 examine a topic and convey ideas, concepts, and
Iinformation through the selection, ceganization, and analysis of relevant content. Introduce a topic clearly, préviewing what is to
{follow, organize ideas, concepts, and Information into broader categories; Include formatting (e.g, headings), graphics (e.g.,
charts of tables), and multimedia when useful 1o 2d comprehension

A Rubric

The response |5 fully sustained and consistently and purposefully focused:

« controlling idea or main idea of a topic Is focused, clearly stated, and strongly maintained
« controfling ides or main ides of a topic is introduced and communicated clearly within the putpose, sudience, and task

The response has & clear and effective ceganizational structure creating unity and completeness:

6. On the ltem & Score tab (see Figure 76), click the edit button #" in the Scoring Criteria table at the
top of the window.

7. Review the student’s entered response and do one of the following:

= Ifthe student’s response is scorable, select the appropriate score from the drop-down menu
in the Points Earned column.

= [fthe student’s response cannot be scored for any reason, select the appropriate condition
code from the drop-down in the Condition Code column. For more information about
condition codes, see Condition Codes in Appendix B.
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10.

11.

12.

13.

Figure 76. Item View Window: Item & Score Tab

INTERIM: HS-ELA-Focused| AB-WriteReviseExplanatory
< Student  Firstnm, Lastnm 5
63152 Eleanor Roosevelt - Brief Write Item & Score Rubric & Resources
Seoring Criteria Max Points Points Earmed Condition Code
Comect Answer 2pt Not Scored & None
Scoring Note
User Date Mote
+ Add Note
ltem Language:  English ~
student setting(s)

~

E .

If the Teacher-Authored item has multiple scoring criteria, repeat step 7 for each criterion.

=  When assigning condition codes to multiple scoring criteria, note that some related criteria
may require the codes to be the same.

Click Save.

Optional: If you wish to provide an explanation for why you chose the given score(s) or condition
code(s), click Add Note in the Scoring Note section, then enter your comment and click Save. All
notes will be deleted when scores are submitted, as described in Submit Scored Test Opportunities
for Processing.

To continue scoring Teacher-Authored items, do one of the following:

= Toview another unscored item for the same student, use the buttons labeled with the
previous and next item numbers at the upper corners of the scoring window.

* Toview the same unscored item for another student, click the up or down arrows on the
right side of the Student field at the top of the window.

* Toreturn to the Scoring Mode window and select another item manually, close the Item
View window using the close button at the upper-right corner.

Repeat these steps until you have entered scores for all the unscored items for the Teacher-
Authored test.

Optional: If you need to change the entered score for a Teacher-Authored item response, you can
select the score link for that item on the Test Scoring page and repeat steps 5-11.
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Once you have entered scores for all the unscored items in a test opportunity, you may submit that
opportunity for processing.

To return to reports, click the close button at the upper-right corner.

How to Change the Selected School

Scoring mode allows you to score the item responses for only one school’s test opportunities at a time.
If you are associated with multiple schools, you may change the selected school in order to score the
test opportunities from other schools.

1. Tochange the selected school, click Change School in the top-right corner of the Dashboard. The
Select School page appears.

Figure 77. Select School Page

Select School

Flease select the School you wish to use.

TA (@ School: Demo inst 9999 w

2. From the Teacher drop-down menu, select the school whose student responses you wish to score.

Teacher

3. Click Continue. The Dashboard page appears, displaying the tests available for the selected school.

How to Submit Scored Test Opportunities for Processing

In order for a Teacher-Authored test opportunity’s scores to be reported, you will need to submit that
opportunity for processing. You may only submit an opportunity once you have entered scores or
condition codes for every hand-scored item on the test.

1. To submit scored opportunities for processing, navigate to the Test Scoring page (see Figure 78) and
mark the checkbox in the Submit column for each opportunity you wish to submit.

*  You can mark the checkbox at the top of the Submit column all fully scored opportunities at
once.
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Figure 78. Test Scoring Page: Submitting an Opportunity

Dashboard 3 Test Scoring

Change School
INTERIM: HS-ELA-IAB-PTExplanatory (School/District Conversation) to score for Demo inst 9999, -
2022-2023
| Submit Student ¥ StudentID Date Taken Items to Score
Item Numbers and Max Points
1 2 3
2pt 2pt 6pt
LAST, FIRST WAMIQAIE — 2/6/2023 3:09:48 PM 0 0 2
LAST, FIRST WAMIQAIE  6/14/2023 121446 PM  Score Score o[
! [Score is machine scored, and should be checked.
Rows per page: 16 2 ltems: 1 of 1

Submit Score(s)

2. Click Submit Score(s) in the bottom-left corner of the page.

3. Inthe confirmation window that pops up, click Continue. The selected opportunities will be
submitted for processing and reporting and removed from scoring.

To return to reports, click the close button at the upper-right corner. You can still modify the item scores
on that test directly from the reports by following the procedure in the next section (How to Modify
Score for ltems).
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How to Modify Scores for Items in Reports
You can modify scores for some items directly from the Item View window that opens from a report.
Reports display a pencil icon #* in the column header for each item with a modifiable score (as in Figure

79). When a machine-suggested score has a low confidence level, or when a condition code of Non-

Specific or Uninterpretable Language has been assigned by machine, f’B displays next to the score. It is
highly recommended that you review items flagged with this icon.

Figure 79. Student Performance on Test Report with Expanded Total ltems Section

Select Role > Dashboard Generator > Dashboard > Performance on Tests > School Performance on Test > Roster Performance on Test eyt Q
> Student Performance on Test S

-l . ¢ s

I=  Score, Performance and Points Earned on Grade 3 ELA - Brief Writes (1AB) (Test Five) of zzz Cambium Training

,.: School1, by Student and Reporting Category: 2022-2023 3t Features & Tools

Fiteced By Rosters: All Rosters | Test Reasons:Test Five | Standards Keys )

T e oo o I c I
Standards g _g‘
= 2 Item Numbers, Max Points and Points Earned
Rerformacce ; 12| 2e| 3e| 4e| se| se
2pt 2pt 2pt 2pt 2pt 2pt
State na na na na na wa wa
777 ©
District i o 1 0.5 1 1 0.5 15
Count 2
A7 o
Institution Parcess 1008 2 0 1 1 0 1
Cowrr 1
(77 o
My Students i ey 2 0 1 1 0 1
Court 1
Demo, BOBBIE 9999999441 Above Standard 2 9 1 1 ] 1
Scores of items marked with €. can be reviewed
Rows per page: 10 1 Rems: 1 of1

1. Onareport with modifiable scores, click the item score link in the student’s row of the report. The
Item View window opens.

69



Centralized Reporting User Guide

2. Optional: You can open the Rubric & Resources tab (Figure 80) to review the item’s scoring rubric
and any other available resources, such as an exemplar and training guide for scoring the item.

Figure 80. Item View Window: Rubric & Resources Tab

(]
£ men 25 Student:  LAST2011, First2011 >
Curvent item: 28 Score 410 fem & Score Rubric & Resources
# Detalls

Topic Weiting and Language Content Alignment Domain: W. Writing Standards
Sndards Cluster: WiB.TTP: Text Types and Purposes
‘Standard: W8 TTPIELA.8.21a: Write Informative/explanatony texts 1o examing o topic and convey ideas, concepts, and
information through the selection, ceganization, and analysis of relevant content. Introduce a topic clearly, previewing what is to
follow, crganize ideas, concepts, and information into broader categories; inchude formatting (e.g., headings), graphics (e.g.,
charts o tables), and multimedia when useful 1o sid comprehension.
# Rubric

The response Is fully sustained and consistently and purposefully focused

» controlling idea of main idea of a topic is focused, clearty stated, and strongly maintained
+ contralling idea or main idea of a topic is intreduced and communicated clearty within the purpose, sudience, and task

The response has a char and effective ceganizational structure creating unity and completeness:

3. Onthe Item & Score tab (see Figure 81), review the student’s entered response and click the pencil

button in the Scoring Criteria table at the top of the window. The Points Earned and Condition Code
columns become editable.

Figure 81. Item View Window: Item & Score Tab

INTERIM: HS-ELA-FocusedIAB-WriteReviseExplanatory

< Student:  Firstnm, Lastnm 5
63152: Eleanor Roosevelt - Brief Write item & Score Rubric & Resources
Scoring Criterla Max Points Points Eamed Condition Code
Correct Answer 2p Mot Scored y‘ hone
Scoring Note
User Date: Note
+ Add Note

Item Language:  English

student setting(s)

E v

4. Do one of the following:

To enter a score for the response, select a numerical score from the Points Earned drop-
down list.

To assign a condition code to the response, select one from the Condition Code drop-down
list.
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5. If the item has multiple scoring criteria, repeat step 4 for each criterion.
6. Click Save.

7. Optional: If you wish to provide an explanation for why you chose the given score or condition code,
click Add Note in the Scoring Note section, then enter your comment and click Save.

8. To continue modifying scores, do one of the following:

= Toview another item for the same student, use the buttons labeled with the previous and
next item numbers at the upper corners of the Item View window.

= Toview the same item for another student, use the up or down arrow buttons on the right

side of the Student field m at the top of the Item View window.

The performance data in the test results update automatically when you close the Item View window.

How to Set Up Your Interim and Modular Reports

Interim and modular reports can be set up differently than summative reports. You can assign test
reasons to modular test opportunities, filter interim and modular opportunities by test reason, and filter
interim and modular tests by standard.

How to Assign Test Reasons (Categories) to Modular Test Opportunities

Test reasons are categories used to classify test opportunities for reporting purposes. They typically
indicate the timeframe in which tests were taken, and they’re a good way to organize tests into groups.

Test reasons should ideally be assigned in the Operational Test Administration Interface at the time of
testing. However, you can use the Test Reason Manager in Centralized Reporting to assign a different
test reason to a modular test opportunity after the test is completed. The Test Reason Manager can be
used to update test reasons for opportunities taken during the current administration. You will not be
able to update test reasons for opportunities taken during previous school years.

Please note, starting in the 2021-2022 administration, interim tests will be assigned specific test reasons
depending on the test window in which the tests were administered: Fall Interim, Winter Interim and
Spring Interim. You will not be able to assign test reasons for interim tests. The following steps provide
additional information on how to Manage Test Reasons for Modular opportunities. Summative and
Interim test reasons cannot be reassigned.

1. From the Features & Tools menu, select Manage Test Reasons. The Test Reason Manager window
opens (Figure 82).
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Figure 82. Test Reason Manager Window

Test Reason Filler

Session Start Date

Fiease selecl a gale range r.

Select a Test Reason v

Test Reason Manager u
== Search Test Sessions for Test Reason
Session ID Please Type a Session ID

End Date:

2. Tosearch for the test opportunities you wish to categorize, do either of the following:

= Inthe Session ID field, enter the session ID in which the opportunities were completed in TDS.

= Select the test reason associated with the opportunities you want to edit. Then select a range
of dates during which the test session was administered. The date range cannot exceed

seven days.

3. Click Search.

4. Alist of retrieved test sessions appears in the section Select Test Opportunities (Figure 83). You can
click the 4 buttons to expand the list of tests in each session and the list of students who took
each test (that is, individual test opportunities). To navigate through a long list, use the controls in
the upper-right and lower-right corners.

72



Centralized Reporting User Guide

Figure 83. Test Reason Manager Window: Select Test Opportunities
]

Test Reason Manager
= Search Test Sessions for Test Reason

Please Type a Session ID

Session ID
o

Test Reason Filtsr Any v
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Assign Test Reasons

5. Mark the checkboxes for each session, test, or opportunity that you wish to assign to a test reason.

6. Click Assign Test Reasons below the list of retrieved sessions.

In the window that appears (see Figure 84), select a new test reason to assign to the selected

opportunities and click Confirm.

7.

Figure 84. Confirm Test Reason and Assign Opportunities Window
x|

Test Reason Manager
= Search Test Sessions for Test Reason

Please Type a Session ID

Session 1D

Test Reason Filler: Any

) | Please select 2 date range o more than 7 days.

End Date: 0710472019

Session strtDate oroa01s )
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Select Test Opportuni
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UAT-0C0B-1 Last, First
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Assign Test Reasons
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How to Filter Interim and Modular Test Opportunities by Test Reason (Category)

Test reasons (shown in Figure 85) are categories used to classify test opportunities for reporting
purposes. They typically indicate the timeframe in which interim and modular tests were taken, and
they can be a good way to focus on specific groups of tests. For summative assessments, test reasons
are simply test windows and are not useful.

Figure 85. Teacher View: Performance on Tests Report
Select Role » Dashboard Generator » Dashboard » Performance on Tests Enter Student IT Q

—
= A~ My Assessments 3! Features & Tools
Fihers

Average Score and Performance Distribution, by Assessment: All Rosters, 2022-2023
Filtered By Rosters: All Roster | Test Reasons: All Test Reasons |

=4
wm
Test

Groups Student Average Date Last
Assessment Name Test Group Test Grade Test Reason Count pe Taken T
(& & messossmaning v TestAuthoring 6 Unassigned 1 0% @ | 01192023
l'lr::ﬂl
&, | Test 547499 Science 1/19 | Test Authoring 4 Unassigned 1 =9 01/19/2023
Raosters
&, Test 546812 Wv 1/17 '  Test Authoring 6 Surmmer 2023 1 0% @ 01/17/2023
Rows perpage: 3 5 Items: 1 of2 »
A My Students

Most Recent Assessment of All Rosters: 2022-2023
Filtered By Rosteérs: All Roster | Test Reasons: All Test Reasons |

Studant Name Student ID Mast Recent Assessment Date Taken
Test Test 716623001 Test 547498 Math 1/19 01192023
Rows per page: 6 1 hems: 1 af1

When your test opportunities have test reasons, you can filter reports by a single test reason. For
example, you may want to filter by Fall and look at ELA performance, then filter by Spring and see if
students have improved on ELA material. If you don’t filter, you'll see data for all different test reasons.
This will allow you to compare multiple test reasons side by side rather than a single test reason. You
may find reports easier to understand when you're viewing only a single test reason.

The Test Reason filter is available on the dashboards and Performance on Tests reports for teachers as
well as for school- and district-level users.

1. Onthe left side of the dashboard or Performance on Tests report, click the Test Reasons button. The
Filters panel expands (Figure 86).
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2. Make a selection from the drop-down list in the Test Reasons section.

Figure 86. District-Level User View: Performance on Tests Report with Expanded Filters Panel

Select Role > Dashboard Generator > Dashboard > Performance on Tests t t Q
-
Filters . Average Score and Performance Di , by : Demodistrict9996, 20222023 i1 Features & Tools
Fitered By School: All Schools | Test Reasons: All Test Reasons
@. R e G Test Test Test Student Average Date
3
Assessment Name Performance Distribution  Last
Group Grade Reason Score Token
T A TestReasons .
@ " Interim 18t N e
& Module 1 n/a Poveint 1000 08/18/2022
All Test Reasons v Assessment opportun peses
. i a _ B o
s & B Module 3 1 WE et oo 08/18/2022
& 3 Assessment opportun Count :
Interim ) - I o
&> Module 1 na Percent 1008 08/18/2022
Assessment opportun Coun
" interim et { o
Modul 4 ¢ 1 Pcent f00% 08/18/2022
i A'.G(‘.’.Sr:rn! opportun Ao Count e :
Clear Filters

m Rows per page: 4 9 ltems: 1 of3 )

3. Click Apply. The report updates to show only data for that test reason.

4. Optional: To revert all filters to their defaults, open the Filters panel again and click Clear Filters.
Click Apply. Filters will also revert when you log out, switch user roles, or switch systems.

All the reports accessible from this page will be filtered the same way.

The row of filter details below the table header shows the test reason selected, if any.

How to Filter Item-Level Data on Interims and Modulars by Standards and Clusters of
Standards

You may want to see how your students performed on a particular standard or cluster of standards. In
certain reports, you can filter by the standard to which items are aligned. That way you can view your
students’ performance in just one area of skill; you can then switch filters to compare it with their
performance in another skill. If you don’t filter by standard, the reports will show results for all
standards by default. You may find that switching between different sets of standard data and
comparing them helps you understand students’ abilities better.

Standard filters are available in any report showing item-level data. The available standards vary by
assessment.
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1. Onthe left side of the page, click the Standards button. The Filters panel expands (Figure 87).

2. Use the drop-down list in the Standards section to select a cluster. An additional drop-down list
appears.

3. Optional: Keep making selections from the drop-down lists as they appear.

Figure 87. My Students’ Performance on Test Report: Performance by Roster Tab with Expanded Filters

Panel
Select Role * Dashboard tor » D » Performance on Tests » My Students’ Performance on Test Enter Student ID Q,
=7 Performance by Roster | Performance by Student e

l;‘ ~ Sandards

Average Score, Performance Distribution and Average Points Earned on Test 547498 Math 1/19
(Unassigned), by Roster and Reporting Category: 2022-2023
Filtered By Rosters: All Roster | Test Reascns:Unassigned | Standards Keys Bl

Damain

RPNS: Ratios and Propor ~

e+ 0 ©
Chuster g 2.
6.NS.c3: Apply and extens [ Item Numbers and Points Eamed
Standand § all 2
M.6.8: Understand that pc ~ M68 [ ] M68 (]
1pt 1pt
State na na
District 0 0
School 0 ]
My Students 0 0
Test_roster NonProctored 0 0

Clear Filters

m Rows per page: 9 1 emg: 1 el

4. Click Apply. The affected report updates to show only the items that belong to the selected cluster
or standard.

5. Optional: To revert all filters to their defaults, open the filters panel again and click Clear Filters.
Click Apply. Filters will also revert when you log out, switch user roles, or switch systems.

All the reports accessible from this page will be filtered the same way.
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The row of filter details below the table header specifies the standards selected, if any.

How to Export and Print Data on Interims and Modulars

You can export or print any report you see in the Centralized Reporting. Some reports on individual tests
can be exported directly from the Performance on Tests report. You may want to export or print to save
a snapshot of data to consult later, or to share data. Different options will be available depending on the
report you are viewing. Some interim and modular reports can be exported with item-level data.

Export or Print a Report You're Viewing

1.

Select the print button from the Features & Tools menu, or, in some reports, from the upper-right
corner. If there are multiple report tables on the page, multiple print buttons will appear.

A print preview page opens (Figure 88).

= Tozoom in on the print preview, use the drop-down list under the Zoom Level (Display only)
section. This setting affects the preview only.

Figure 88. Print Preview Page

Zoom Level (Display only)

Reporting

Normal -

Average Score, Performance Distitution and Average Points Eamed on Test
Report Options 547498 Math 119 [Unassigned), by Roster and Reporling Category: 2022-2022
Fimered By Rosters: A8 Soster | Test Reasons: LTIRRGTET |

— —

R
S

® Summary Only
Summary and Item Scores

Tutwr Card Ta Zamow See

: i

Print Options -~
® Print
*Printed image may vary from

preview. Please check yo
browner's prin: sertings and

w

i
a9 99

]

T S e Ll
ensune background image
printing is enabled

Copyrignt © J23 Camblum Assesement Ine. Al Fights resensd
Save to FDF

Save to Excel
Save to CSV

“The data in this report will be
exported to a comma separated
value document
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2. If an aggregate report provides data for individual items, the Report Options section appears. Select
either Summary Only or Summary and Item Scores. If you select the latter option, as in Figure 89,
the printed report includes data for the individual assessment items. Printouts of the Student
Performance on Test report always include item data if available.

Figure 89. Print Preview Page with Summary and Item Scores Option Selected

Zoom Level (Display only)
Reporting
Mormal w
Average Score, Performance Distribution and Average Points Earned on Test
wr‘ apllnm 5474598 Math 1/19 (Unassigned), by Roster and Reporting Categony: 2022.2023
Fibeoed By Rosters. AN Rosser | Teet Redeons: Unassigned
Summary Only
— TR
® Summary and ltem Scores m
e we Fama . il S —
[ry— B St Tt St Bale : Sors wes LES
Print Options = =
- an L L]
W D L]

preview. Please check your
berovwmer's print settings and
ensure backgreund image
printing is enabled

=

*Frinted image may vary from p— ) - w1
=
=

Save to PDF Copyight © 2023 CHMDILM ASISIETETL, InG. ANl NIgHEE resened

Save to Excel
Save to C3V

*The data in this report will be
expomed 10 8 comma separated
vahse docurnent

m | I:a"'::‘-‘l |

3. To print the report, select the Print radio button. To download it, select Save to PDF, Save to Excel
(XLSX), or Save to CSV (comma-separated values).

9. Optional: If a printout or PDF is for a particular student and the report includes items, you
can mark the Include Items and Responses (takes extra time) checkbox. The resulting report

includes the actual items and the student’s responses.

10. If you selected Save to PDF, choose an option from the Page Layout drop-down list that

appears.

4. Click Confirm.
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If you saved the report as a PDF, Excel, or CSV, the Secure File Center window appears, displaying the
generated report.

How to Export an Assessment Report Directly from the Performance on Tests Report
1. Click .i. to the left of the name of the assessment whose report you wish to export (see Figure 90).

Figure 90. Teacher View: Performance on Tests Report
Select Role » Dashboard Generator » Dashboard * Performance on Tests Enfter Student I[ Q

-
= A My Assessments 33! Features & Tools
Fihers

Average Score and Performance Distribution, by Assessment: All Rosters, 2022-2023
E=:; Filtered By Rosters: All Roster | Test Reasons:All Tesi Reasons |
an

Tem

Groups Student Average Date Last
Assessment Name Test Group Test Grade Test Reason Count S Taken
IT_é Test 547498 Math 119 »  Test Authoring ] Unassigned 1 0% @ 011972023
i
nlr:wnl
&, | Test 547499 Science 1/19 “  Test Authoring 4 Unassigned 1 ™0 01/19/2023
Rosters
&, Test 546812 WW 1/17 w  Test Authoring ] Summer 2023 1 0% @ 01/17/2023
Rows per page: 3 5 ltems: 1 of2 »
A My Students

Most Recent Assessment of All Rosters: 2022-2023
Filtered By Rosters: All Roster | Test Reasons: All Test Reasons |

Student Name Student ID Mast Recent Assessment Date Taken «
Test Test 71662300 Test 547498 Math 1/19 01192023
Rows per page: | & 1 ltems: 1 of1

The Export Report window opens. The options in this window vary according to your user role.
2. Select which report to export for the assessment.

= District-level users:

— To export the district test results, mark the Overall Performance of all my Schools radio
button.

— To export school test results (excluding data for individual items), mark the Overall Test
& Reporting Category Performance of all my Students for [School Name] radio button,
then select a school from the drop-down list.

— To export school test results (including data for individual items), mark the Overall Test,

Reporting Category and Item Performance of all my Students for [School Name] radio
button, then select a school from the drop-down list.

79



Centralized Reporting User Guide

Figure 91. District-Level User View: Export Report Window

Export Report for Summative Grade 3 MATH

Choose Type of Report

1.  ® Overall Performance of all my Schools

O Overall Test, Reporting Category Performance of all students

Select School ~

Select Export File Type
2. @®PDF OExcel OCSV

Export Assessment Data

= School-level users and teachers:

— To export results for all your associated students (excluding data for individual items),
mark the Overall Test, Reporting Category Performance of all students. radio button.

— To export results for all your associated students (including data for individual items),

mark the Overall Test, Reporting Category and Item Performance of all students. radio
button.

Figure 92. Teacher View: Export Report Window

Export Report for Test 547498 Math 1/19

Choose Type of Report

1.  ® Overall Test, Reporting Category Performance of all students
O Overall Test, Reporting Category and Item Performance of all students
Select Export File Type

2. @PDF OExcel OCSV

Export Assessment Data

3. Choose from the PDF, Excel, and CSV formats.
4. Click Export Assessment Data. A confirmation window appears.

Click Yes to export or No to return to the Export Report window. When you’ve exported a file, the
Secure File Center window appears with the generated file available for download.
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e Tip: If you are having difficulty accessing a report in the Secure File Center, be sure to clear your
cache and cookies. If you are still having difficulty, navigate to Centralized Reporting using an
Incognito Tab.
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Appendix A. Roster Management

Rosters are groups of students. Each user-defined roster is associated with a teacher except when
created at the district level. Each roster is associated with a teacher. Each is also associated with a single
administrative year.

Teachers, school-level users, and district-level users can add, edit, and delete user-defined rosters.
Rosters are a great way to organize students, allow teachers to view their students’ performance, and
allow other users to compare the performance of different students.

How to Add a Roster

You can create new rosters from students associated with your school or district.

1. From the Features & Tools menu, select Add Roster. The Roster Manager window appears,
showing the Add Roster form (see Figure 93).

Figure 93. Roster Manager Window: Add Roster Form

Add Roster a

School Detalls

District: De
Schoot: De

Find and Select Students Roster Details

Roster “Toacher Namw v

Selected Students (0)

v X REMOVEALL  STUDENT NAME GRADE SSID

+ Additional Flelds

2. If necessary, select the district and school for the roster from the drop-down lists.
3. Add a roster name and select a teacher.
4. Decide how you want to add students:
11. Quick Roster tab (search adds students automatically, manually remove students to edit)

— Use the Quick Roster tab to create a roster from a group of students. Once you select
the search criteria, all students who meet those criteria are automatically added to the
roster after you select Create Quick Roster. You can remove students manually by

selecting X next to individual students or select Remove All from the top of the grid.
Selecting Save creates your roster.

12. Student Search tab (search finds students that you add and remove manually)
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— Use the Student Search tab for a more traditional search function, including the option

to find specific students by ID or name. After you return results, select + to add
individuals or select Add All from the top of the grid.

> Tip: To return fewer students, limit your search by adding more criteria. Expand the Additional
Fields section to add student information criteria as available.

5. Optional: After results appear under Selected Students, change the information that displays about
students.

13. Show more information drop-down: Select or clear additional columns under
Available/Selected Students grids.

14. Use the Filter field to limit students to those who match the text you enter.

This keyword search only finds text in the grid. Be aware if you enter 11 to find students in 11th
grade, any content with the text “11” will display. This could potentially pull in results you did
not intend to find.

6. After you save, rosters may be changed from the Edit Rosters screen.

How to Modify a Roster

You can modify a user-defined roster by changing its name, changing its associated teacher, adding
students, or removing students.

1. From the Features & Tools menu, select View/Edit Roster. The Roster Manager window appears,
showing the View/Edit/Export Roster form (see Figure 95).

Figure 94. Roster Manager Window: View/Edit/Export Roster Form

Roster Manager n

View/Edit/Export Roster

@ Use this page to view, edit, or delete rosters. more info

Search for Rosters to Edit

Note: For multiple roster selection, you may print 1000 students at a time.

rch terms to filter
Number of rosters found: 19

Roster Name Teacher Grades In Number Of
Roster Students

Demo Roster 1 TE1, DemoUser 03, 05

Demo Roster 2 TE1, DemoUser 01 3

Demo Roster 3 TE1, DemoUser 03 2

Demo Roster 4 TE1, DemoUser 01,03 2 .

2. Select the school year, district, school, and roster type as needed for the roster you wish to edit.
Optionally, select a teacher.
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3. Click Search. Click View Results to view the results in your browser.

4. Inthe list of retrieved rosters, click the pencil button for the roster whose details you want to view

The View/Edit window for the roster opens.

Figure 95. Roster Manager Window: View/Edit Roster Form
View/Edit Winter EOC

Search Results Roster Details
Enrolled Grade: 09, 10

You can change the name and teacher associated with this roster.
A roster works best with about 30 students, although you can have up to 500 active students

*Roster Name: Spring History EOC
on each roster.

*Teacher Name: = LastName, Firstname v
Change Search

Available Students (0) Selected Students (3)

Show more information  w Filter students Show more information v Filter students

STUDENT NAME ENROLLED GRADE SSID DATELEFT ADDALL + X REMOVE ALL  STUDENT NAME ENROLLED GRADE  SSID DATE LEFT

X LastName, FirstName 09
X LastName, FirstName 09

X LastName, FirstName 10

5. To add students, select Find Students. Select the Student Search tab to add individual students
manually, or select the Quick Roster tab to add a group of students and then remove individual

students who do not need to be on the roster. After you return results, select + to add individuals
or select Add All from the top of the grid.

"] Note: Each user-defined roster can only be associated with one school, so the search options do
not include a way to search for a school.

To remove students, click X next to an individual student or select Remove All from the top of the
grid.

7. Select Save, and in the affirmation dialog box select Continue.

How to Upload Rosters

If you have many rosters to create, it may be easier to perform those transactions through file uploads.

This task requires familiarity with composing comma-separated value (CSV) files or working with
Microsoft Excel.

1. From the Features & Tools menu, select Upload Rosters. The Roster Manager window appears,

showing the Upload Rosters: Upload page (see Figure 96).
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Figure 96. Roster Manager Window: Upload Rosters: Upload Page

Upload Rosters

@ Use this page to upload a file to create rosters. /more info =

Upload
Find afile

Step 1: Upload File

Template

The format of your data is
important. Use a template to get
started.

Download Template

Drag & drop a file to upload History

View a history of uploads to this page.

Choose File

2. Click Download Template on the right and select the appropriate file type.
3. Open the template file in a spreadsheet application, fill it out, and save it.

4. Onthe Upload Rosters: Upload page, click Choose File and select the file you created in the previous
step.
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5. Click Next. The Upload Rosters: Preview page appears (Figure 97). Use the file preview on this page
to verify you uploaded the correct file.

Figure 97. Roster Manager Window: Upload Rosters: Preview Page

Upload Rosters

@ If the values in the columns do not match the headings in the table, use a template from the previous Upload Rosters page

© 2]

Upload Preview Validate Receive Confirmation
Find afile Preview upload Fix errors All done

Step 2: Preview

Check that you've uploaded the correct file. Only the first 10 rows display on the preview.

Record Number District ID School ID Email address Student ID -
1

9999999999 9999999999-9999999990 @test.user Sample 1
2 0 |@lest,user Sample 1
3 9999999999 09999999999-9939999990 (@test.user Sample 1
4 0 |@|est.user Sample 1 -

6. Click Next to validate the file.

Any errors or warnings are displayed on the Upload Rosters: Validate page (see Figure 98). If a
record contains an error, that record will not be included in the upload. If a record contains a
warning, that record will be uploaded, but the field with the warning will be invalid.

Figure 98. Roster Manager Window: Upload Rosters: Validate Page

Upload Rosters

@ Roview the validation results below. | meare info -

o o o

Upload Preview Welidate Receive Confirmatior
Fing afile Praview upioad Flx efmars

Step 3: Validate
@ 3 rocord(s) will be processed

a 1 record(s) with emers cannot be processed. [o include these records, review the tables below. Then edit and upload your revised file

Summary

Shows an overview of issue types in your file with the number of times each izsve occurs. Gives a solution for eech type when possible.

weming Type
1

Usze 3 Student ID that 1s enrolled Inthe Schoal. |[EmorCods700814)

) Error: student 1D 1s not enralled In this Schoo

Details

Shows the Record Mumber and column of each issue in vour file. S2lect the icons for information about each issue. Note: Record Mumbers are one less than the row numbers for Excel
files with column labels in the first row.

District ID Cimiad adi¥ess RioiS1Er Name Student D Actian

4 Ll el 199999%995-2009900050 |;§:'.e st user Sample 1 e

| Upload Revised File ” Continue with Upload || Downlead Validation Report |

15. To revise the file before uploading, select Upload Revised File.
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16. To view a list of issues with the file, select Download Validation Report.

17. To continue with the upload regardless of errors or warnings, select Continue with Upload.
The confirmation screen appears (Figure 99).

Figure 99. Upload Rosters: Confirmation Page

Upload Rosters

Upload Preview Validate Receive Confirmation
Find a file Preview upload Fix errors All done

+/ Your file has been uploaded.

Q 3 record(s) were processed
8 1 record(s) with errors were not processed

Upload New File || Download Validation Report || Download Rejected Records

7. Optional: To upload another roster file, click Upload New File.

Table 8. Columns in the Rosters Upload Fileprovides the guidelines for filling out the Roster template
that you can download from the Upload Roster page.

Table 8. Columns in the Rosters Upload File

Element Description Valid Values
District ID* District associated with the District ID that exists in TIDE. Up to
roster. 20 characters.
School ID* School associated with the School ID that exists in TIDE. Up to
roster. 20 characters. Must be associated

with the district ID.

Can be blank when adding district-
level rosters.

User Email ID* Email address of the teacher Email address of a teacher existing in
associated with the roster. TIDE.

Roster Name* Name of the roster. Up to 20 characters.

WISER ID* Student’s unique identifier within Up to 30 alphanumeric characters.
the district.
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*Required field.
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Appendix B. Condition Codes

Table 9 provides an overview of the various condition codes that may be entered for a machine- or
hand-scored item when a traditional score cannot be entered for the student’s response.

Table 9. Condition Codes

Condition Description
Code
Blank e The student did not enter a response.
Insufficient Text e The student has not provided a meaningful response. Some examples:

= Random keystrokes

= Undecipherable text

= “| hate this test”

= “l don’t know”, “IDK”

= “l don’t care”

= ‘| like pizza!” (in response to a reading passage about helicopters)
= Response consisting entirely of profanity

e For ELA Full Writes, use the “Insufficient Text” code for responses described
above and also if

= The student’s original work is insufficient to make a determination
whether the student is able to organize, cite evidence/elaborate, and use
conventions as defined in the rubrics.

= The response is too brief to make a determination regarding whether it is
ON purpose or on topic.

Non-Scorable e ELA/literacy: Language other than English.
Language e Mathematics: Language other than English or Spanish.
Off Purpose e For ELA Full Writes only:

= A writing sample will be judged off purpose when the student has clearly
not written to the purpose designated in the task.

= An off-purpose response addresses the topic of the task but not the
purpose of the task.

= Note that students may use narrative techniques in an explanatory essay
or use argumentative/persuasive technigues to explain, for example, and
still be on purpose.

= Off-purpose responses are generally developed responses (essays,
poems, etc.) clearly not written to the designated purpose.
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Off Topic e For ELA Full Writes only:

= A writing sample will be judged off topic when the response is unrelated
to the task or the sources or shows no evidence that the student has read
the task or the sources (especially for informational/explanatory and
opinion/argumentative).

= Off-topic responses are generally substantial responses.
Insufficient Text e The response is largely composed of text copied from the prompt.

(Copied Text
from the Prompt)

Insufficient Text e The response is a refusal to respond, in a form such as “idk” or “I don’t
(Refused to know.”

Answer)

Non-Specific e This condition code is assigned to machine-scored responses when TDS

identifies that the response requires a condition code but cannot determine
which specific condition code it requires.

Non-Scorable e The response is in Spanish.
Language

(Spanish

Response)

Non-Scorable e The response is in a language other than English or Spanish.
Language

(Uninterpretable

Language)
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Appendix C. Help Guide

Centralized Reporting includes an online user guide.

How to Access the Online User Guide

In the banner (see Figure 100. Help Guide within Banner), click Help. The guide opens in a pop-up
window, showing the help page specific to the page you’re on. For example, if you click Help while on
the dashboard, you’ll see the Overview of the Dashboard page.

Figure 100. Help Guide within Banner

C3 Secure File Center @ Help
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Appendix D. Secure File Center

Centralized Reporting allows you to access a Secure File Center that is integrated with other online
assessment systems, such as TIDE, and accessible from your portal. The Secure File Center serves as a
central repository for secure documents uploaded by administrators (such as state personnel) or shared
between users, files exported by users, and hotline alerts.

Each user’s Secure File Center is personal to them and not shared among other users. Users can easily
manage the files in their Secure File Centers. The files are categorized into different tabs to allow users
to view non-archived and archived files. Users can also search for files by keyword. Files are listed in the
order in which they were created. The file creation and file expiration dates appear, if applicable, and
the number of days remaining until a file expires is also displayed. Users can archive or delete files as
needed. Users can also share files by sending them to other users’ Secure File Centers.

If you are having difficulty accessing a report in the Secure File Center, be sure to clear your cache and
cookies. If you are still having difficulty, navigate to Centralized Reporting using an Incognito Tab. How
to Access and Manage Files in the Secure File Center.

Figure 101. Secure File Center within Banner

(3 Secure File Center @ Help

Access and Manage Files in the Secure File Center

The files in the Secure File Center are listed in the order in which they were created. The file creation
and file expiration dates appear, if applicable. The number of days remaining until a file expires is also
displayed next to a file. By default, exported files are available for 30 days while secure documents are
available for the period specified by the DOE. You can access the Secure File Center from any page in
Reporting to either download the file or archive the file. You can also delete the files you have exported,
but not files added by admin users.

1. Inthe banner, click Secure File Center. The Secure File Center window appears (Figure 102). By
default, the Secure File Center displays the View Documents tab.
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Figure 102. Secure File Center Window: View Documents Tab: Recent Sub-Tab

Secure File Center

Secure File Genter o v
Recent Archived
TIDE

Reporting 07/18/2023 09:53 08/17/2023 09:53
2 _StudentiSRs_095328175 AM.pcf | Reporting A A
A Custom Labels
0 e 06/26/2023 12:31 07/26/2023 12:31 —
2 RostersAtDemo School 1.csv | TIDE PM PM O
3 06/26/2023 12:30 07/26/2023 12:30 /= =
.} 2 UsersAtDemo District 1.xlsx TIDE PM PM - O

2. Choose either of the available tabs (Figure 102):
18. Recent: Displays all files except those that have been archived.
19. Archived: Displays files that have been archived.
3. Optional: To filter the files displayed, enter a search term in the text box in the upper-right corner.
4. Optional: To hide or display system labels, click the System Labels toggle.
5. Optional: To hide files with a particular system label, clear the checkbox for that label.
6. Optional: To hide or display custom labels, click the Custom Labels toggle.
7. Optional: To hide files with a particular custom label, clear the checkbox for that label.
8. Optional: Do one of the following:

20. To download a file, click the name of the file.

21. To add a new custom label or apply an existing custom label, select .

— To apply a new custom label, mark the checkbox, enter a new custom label in the text
box, and select Save New Label.

— To apply an existing custom label, mark the checkbox, enter an existing custom label in
the text box, and select Apply Label.

22. To archive a file, select . To unarchive a file from the Archived tab, select @

23. To delete afile, select D Files exported to the Secure File Center or archived can be
deleted. However, secure documents uploaded to the Secure File Center by admin users
cannot be deleted.
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How to Use the Secure File Center to Send Files to Other Users’ Secure File Center

You can send a file or files to individual recipients by email address or to groups of recipients by user
role.

1. From the banner, select Secure File Center. The Secure File Center page appears. By default, the
View Documents tab displays.

2. Select the Send Files tab. The Send Files page appears (see Figure 103).
3. Inthe Select Recipients field, do one of the following:
= Select By Role to send a file or files to a group of users by user role.
= Select By Email to send a file or files to a single recipient by email address.

= |f you select By Email, skip to step 7.
Figure 103. Secure File Center Window: Send Files Tab

Secure File Center

‘ Secure File Center O View Documents B Send Files -

Select Recipients

ORrole O Email

Select Role(s)

O stateroles O Districtroles O School roles

v Select Organization(s)

Add File

Browse

0 of 10 documents

* By clicking Send, you agree that Cambium Assessment cannot be held liable for data shared as a result of sending these files.

4. Inthe Select Role(s) field, select the role group to which you want to send a file or files. A drop-down
list appears.

5. From the drop-down list select the role(s) to which you want to send a file or files. You can choose
Select all to send a file or files to all roles in the selected role group.
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6. From the Select Organization(s) drop-down lists, select organizations that will receive the file(s) you
send. These drop-down lists adhere to the user role hierarchy. For example, district-level users will
be able to filter at their role level and below.

7. If you selected By Role in step 3, skip this step. If you selected By Email, enter the email address of
the recipient to whom you wish to send a file or files.

8. Toselect afile or files to send, in the Add File field, select Browse. A file browser appears.
9. Select the file(s) you wish to send. You may send up to 10 files totaling no more than 20MB at once.
10. Select Send.

Files display in the Secure File Center after you send them.

95



Centralized Reporting User Guide

Appendix E. Multiple Modular Test Opportunities

Sometimes modular test results will include multiple rows for the same student.

When a student completes multiple test opportunities for a single assessment, as in Figure 104, reports

display a row of data for each opportunity. A clock icon appears next to the most recent

opportunity. Previous opportunities are marked with numbers

1), starting from the earliest test taken.

An asterisk icon indicates that an opportunity is not included in calculations of average scores or

performance distributions.

Figure 104. Roster Performance on Test Report

Getecl Fole + Duahboand Genealer » Dushiboned » Pefocneoce on Teits * Diskic Perfoomacce on Test » Sobool Perfocmance on Tesd » Reiber Perfomence on Tl aQ
~
TE  Scom, Parmoemance and Points Exmid on Grase 5 ELA - Performance Taak - Whalea (IAB) (Tast Ona) of (tutents not in sy roater]. by Sucint 6nd Reporting Category: 2022-2023 15 Featurss & T
- Filtrnd By Bchost &3 Scfwsiin | Tl Beeni: Teil O | Shasdasdi Keys -
@ e e o N o I
Bt B E Thern Karmibarrs, Max Prings and Poirts Dammed
5 1 [ 3 é 4 é
Performance
40T RS W [ ] ACEE RS W S [ ] SCRM-SAWE [:] Tena-Siw e [ ]
I 1ot Epk bpt
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L L]
My Shissents f— = 2 L] 2 ]
[T KATIE A AN Standard
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R pei page 2 Imema LI

Most Recent Assessment # Opportunity is not included in calculations of average scores and performance levels
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Appendix F. Non-Scorable Test Opportunities

The reports in Centralized Reporting do not include data for non-scorable test opportunities. A student’s
test opportunity cannot be scored when it has a test status of “Expired” or “Invalidated”, or when it
includes blank or empty reporting categories (reporting categories without items). If a test opportunity
is non-scorable, a notification appears below the report for that assessment.

You can click More Info on the notification to view the Students with Other Test Statuses window (see
Figure 105). This window lists the students who have non-scorable test opportunities for the given
assessment, as well as the status code and completion date for each.

Figure 105. Students with Other Test Statuses Window

Grade 3 ELA : Students with Other Test Statuses

Student ID
DemoStudentiD1

DemoStudentiD2

Table 10. Students with Other Test Statuses Window Elements

# Element
1 Condition codes
2 Dates the tests were taken
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Appendix G. Performance Data

Depending on the test, a report may display different kinds of performance data:

® Score data: This type of data is used for tests with numeric scores. Score data provides a
guantitative measurement of student assessment performances. The following columns involving
score data may appear in reports:

o Scale scores.
o Raw scores, which may be in the form of percentages or fractions.

e Standard error: After an individual student’s score, you may see a number with “+” before it. This is
the standard error of measurement (SEM). A student’s score is best interpreted when recognizing
that the student’s knowledge and skills fall within a score range and not just a precise number. As
an example, if a student receives a test score of 75 with an SEM of 4, that tells us that the student’s
knowledge and skills fall between 71 and 79. For average scores at aggregate levels, the number
following “+” is the standard error of the mean.

e Performance-level data are used for tests with performance levels (also known as proficiency
levels). Performance levels provide qualitative measurements of students’ proficiency in relation to
a particular standard or set of standards. Some aggregate reports include performance distribution
bars, as in Figure 106, showing the percentage and number of students who achieved each
performance level. These bars are color-coded, with three performance levels being coded red-
yellow-green, four being coded red-yellow-green-blue, and five being coded red-yellow-green-blue-
purple.

Figure 106. District Performance on Test Report
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e Measures in aggregate reports for adaptive tests may also include Weak or Strong?, Proficient?,
and % Correct.

98



Centralized Reporting User Guide

In a report, click the more information button @ in the score or Performance Distribution columns.

A legend appears (Figure 107), explaining what the scores or performance levels indicate.

Figure 107. District Performance on Test Report with Expanded Performance Distribution Legend
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You will find similar buttons @ in reports throughout Centralized Reporting.
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Appendix H. Report Tables

How to Sort a Table

1. To sort by descending order, click the header of the column you wish to sort by. The bottom arrow
in the header is shaded darker ¥ when the column is sorted in descending order.

2. To sort by ascending order, click the column header again. The top arrow in the header is shaded
darker * when the column is sorted in ascending order.

How to Specify the Number of Rows Displayed

In the Rows per page field below a table, enter the number of rows you want the table to display per
page. Your specifications persist for each table.

You can click the arrow buttons in this field to increase or decrease the number of rows displayed in
increments of one.

How to View Additional Table Rows

e To move to the next and previous pages in a table click the arrow buttons > < at the lower-right
corner of the table.

e Tojump to a specific table page, enter the page number in the field 1

the table.

at the lower-right corner of

How to View Additional Table Columns

To scroll the table to the right or left, click the arrow buttons @ @ on the right and left sides of the

table. Alternatively, click and drag the green horizontal scrollbar at the bottom of the table.

If a table contains expandable and collapsible accordion sections, you can click the section bars to
expand and collapse them.

How to Expand All Accordion Sections in a Table

If you're navigating the page by tabbing through it, you may want to expand all the expandable
accordion sections of a table at once. This feature, which is available in most test results, will make the
table accessible to a screen reader.

1. Navigate to the table by tabbing through the page in your browser. When the “Load Accessible
Table” message appears, press the Enter key. All the accordion sections expand.

2. Optional: To collapse the sections again, navigate back to the table. When the “Hide Accessible

Table” message appears, press the Enter key. All the accordion sections collapse, except the Total
section.
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Appendix I. Test Resources

Some test results in Centralized Reporting include supplementary information that you can access, such
as resources provided for the assessment in Tools for Teachers.

If additional assessment information is available, click Get Instructional Resources in the Features &
Tools menu.

A window opens (see Figure 108), displaying resource links that either download or open in a new
browser tab or window.

Figure 108. Test Resources Window

Test Resources n

Test Resources for Module: Math Grade 3 - Measurement Data and Geometry A

Resource Description

For guidance on reviewing and interpreting student score information in AIRVYays for
Interim Module Assessments, please refer to the information in this Quick Guide.
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Appendix J. User Role Change

If your account is associated with multiple user roles or institutions, you can switch between them.

1. From the banner menu, select Change Role. (Alternatively, click the Select Role link in the path at
the upper-left corner.) The Change Role window appears.

2. From the Role drop-down list, select the desired role and institution (entity name) combination.

3. Click Continue. The window closes and the Dashboard Generator page appears.
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User Support

For additional information and assistance in using Centralized Reporting, contact the Wyoming Help
Desk.

The Help Desk is open Monday — Friday 7:00 a.m. to 5:00 p.m. MT (except holidays or as otherwise
indicated on the Wyoming portal).

Wyoming Help Desk
Toll-Free Phone Support: 1-888-897-8024

Email Support: wyohelpdesk@cambiumassessment.com

Please provide the Help Desk with a detailed description of your problem, as well as the following:

e If the issue pertains to a student, provide the student's WISER ID and associated district or school.
Do not provide the student’s name.

e If the issue pertains to a Test Information Distribution Engine (TIDE) user, provide the user’s full
name and email address.

e Any error messages and codes that appeared, if applicable.

e Operating system and browser information, including version numbers for example, Windows 11
(21H2) and Firefox 87 or macOS 12.3 and Safari 13).
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